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Overview

About This Chapter This chapter provides information about the purpose of this manual, the writing 
conventions used in the manual, minimum system requirements, and safety 
precautions.

In This Chapter The following topics are covered in this chapter:

Topic See Page

About This Manual 1-2

Conventions Used in This Manual 1-2

Safety 1-3
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About This Manual

Purpose This manual provides procedures for operating the Fluorometric Microvolume Assay 
Technology (FMAT™) 8100 High Throughput Screening (HTS) System. It also 
presents

� Theory of operation

� Instrument features

� Software features

� Guidelines for operation

� Troubleshooting information

Conventions Used in This Manual

Writing Conventions This manual uses the following writing conventions:

� Menus, menu items, window, and dialog box names appear in bold characters like 
this when they are given in tables and procedures.

� Examples of information that you type into a text box appear in bold Courier 
characters like this when given in text.
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Safety

Documentation User
Attention Words

Five user attention words appear in the text of all Applied Biosystems user 
documentation. Each word implies a particular level of observation or action as 
described below.

Note Calls attention to useful information.

IMPORTANT Indicates information that is necessary for proper instrument operation.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury. It may also be used to alert against unsafe practices.

Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury.

Indicates an imminently hazardous situation which, if not avoided, will result in 
death or serious injury. This signal word is to be limited to the most extreme situations.

Chemical Hazard
Warning

CHEMICAL HAZARD. Some of the chemicals used with Applied Biosystems 
instruments and protocols are potentially hazardous and can cause injury, illness, or death.

� Read and understand the material safety data sheets (MSDSs) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials.

� Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (e.g., safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

� Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (e.g., fume hood). For additional safety guidelines, 
consult the MSDS.

� Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

� Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

\\

Chemical Waste
Hazard Warning

CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems 
instruments are potentially hazardous and can cause injury, illness, or death.

� Read and understand the material safety data sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

� Handle chemical wastes in a fume hood.

� Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (e.g., safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

� Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (e.g., fume hood). For additional safety guidelines, 
consult the MSDS.

� After emptying the waste container, seal it with the cap provided.

CAUTION!

WARNING!

DANGER!

WARNING!

WARNING!
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� Dispose of the contents of the waste tray and waste bottle in accordance with 
good laboratory practices and local, state/provincial, or national environmental 
and health regulations.

Site Preparation and
Safety Guide

A site preparation and safety guide is a separate document sent to all customers who 
have purchased an Applied Biosystems instrument. Refer to the guide written for your 
instrument for information on site preparation, instrument safety, chemical safety, and 
waste profiles.

About MSDSs Some of the chemicals used with this instrument may be listed as hazardous by their 
manufacturer. When hazards exist, warnings are prominently displayed on the labels 
of all chemicals. 

Chemical manufacturers supply a current MSDS before or with shipments of 
hazardous chemicals to new customers and with the first shipment of a hazardous 
chemical after an MSDS update. MSDSs provide you with the safety information you 
need to store, handle, transport and dispose of the chemicals safely.

We strongly recommend that you replace the appropriate MSDS in your files each 
time you receive a new MSDS packaged with a hazardous chemical.

CHEMICAL HAZARD. Be sure to familiarize yourself with the MSDSs before 
using reagents or solvents.

Ordering MSDSs You can order free additional copies of MSDSs for chemicals manufactured or 
distributed by Applied Biosystems using the contact information below.

For chemicals not manufactured or distributed by Applied Biosystems, call the 
chemical manufacturer.

WARNING!

To order MSDSs... Then...

Over the Internet a. Go to our Web site at 
www.appliedbiosystems.com.

b. Click SERVICES & SUPPORT at the top of the page, click 
Documents on Demand, then click MSDS.

c. Click MSDS Index, search through the list for the chemical 
of interest to you, then click on the MSDS document 
number for that chemical to access a PDF of the MSDS.

By automated telephone 
service

Use “To Obtain Technical Documents” on page E-5.

By telephone in the United 
States

Dial 1-800-327-3002, then press 1.

By telephone from Canada

By telephone from any other 
country

See the specific region under “To Contact Technical Support 
by Telephone or Fax (Outside North America)” on page E-3.

To order in... Dial 1-800-668-6913 and...

English Press 1, then 2, then 1 again

French Press 2, then 2, then 1
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Instrument Safety
Labels

Safety labels are located on the instrument. Each safety label has three parts:

� A signal word panel, which implies a particular level of observation or action (e.g., 
CAUTION or WARNING). If a safety label encompasses multiple hazards, the 
signal word corresponding to the greatest hazard is used.

� A message panel, which explains the hazard and any user action required.

� A safety alert symbol, which indicates a potential personal safety hazard. See the 
FMAT 8100 HTS System Site Preparation and Safety Guide (P/N 4308435) for an 
explanation of all the safety alert symbols provided in several languages.

About Waste Profiles A waste profile was provided with this instrument and is contained in the 
FMAT 8100 HTS System Site Preparation and Safety Guide. Waste profiles list the 
percentage compositions of the reagents within the waste stream at installation and 
the waste stream during a typical user application, although this application may not 
be used in your laboratory. These profiles assist users in planning for instrument waste 
handling and disposal. Read the waste profiles and all applicable MSDSs before 
handling or disposing of waste.

IMPORTANT Waste profiles are not a substitute for MSDS information. 

About Waste
Disposal

As the generator of potentially hazardous waste, it is your responsibility to perform the 
actions listed below.

� Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

� Ensure the health and safety of all personnel in your laboratory.

� Ensure that the instrument waste is stored, transferred, transported, and disposed 
of according to all local, state/provincial, or national regulations.

Note Radioactive or biohazardous materials may require special handling, and disposal 
limitations may apply.
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Before Operating the
Instrument

Ensure that everyone involved with the operation of the instrument has:

� Received instruction in general safety practices for laboratories

� Received instruction in specific safety practices for the instrument

� Read and understood all related MSDSs

Avoid using this instrument in a manner not specified by Applied Biosystems. 
Although the instrument has been designed to protect the user, this protection can be impaired 
if the instrument is used improperly.

Safe and Efficient
Computer Use

Operating the computer correctly prevents stress-producing effects such as fatigue, 
pain, and strain.

To minimize these effects on your back, legs, eyes, and upper extremities (neck, 
shoulder, arms, wrists, hands and fingers), design your workstation to promote neutral 
or relaxed working positions. This includes working in an environment where heating, 
air conditioning, ventilation, and lighting are set correctly. See the guidelines below.

MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards 
are caused by the following potential risk factors which include, but are not limited to, repetitive 
motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, 
and other workstation environmental factors.

� Use a seating position that provides the optimum combination of comfort, 
accessibility to the keyboard, and freedom from fatigue-causing stresses and 
pressures.

– The bulk of the person’s weight should be supported by the buttocks, not the 
thighs.

– Feet should be flat on the floor, and the weight of the legs should be 
supported by the floor, not the thighs.

– Lumbar support should be provided to maintain the proper concave curve of 
the spine.

� Place the keyboard on a surface that provides:

– The proper height to position the forearms horizontally and upper arms 
vertically.

– Support for the forearms and hands to avoid muscle fatigue in the upper arms.

� Position the viewing screen to the height that allows normal body and head 
posture. This height depends upon the physical proportions of the user.

� Adjust vision factors to optimize comfort and efficiency by:

– Adjusting screen variables, such as brightness, contrast, and color, to suit 
personal preferences and ambient lighting.

– Positioning the screen to minimize reflections from ambient light sources.

– Positioning the screen at a distance that takes into account user variables 
such as nearsightedness, farsightedness, astigmatism, and the effects of 
corrective lenses.

� When considering the user’s distance from the screen, the following are useful 
guidelines:

– The distance from the user’s eyes to the viewing screen should be 
approximately the same as the distance from the user’s eyes to the keyboard.

CAUTION!

CAUTION!
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– For most people, the reading distance that is the most comfortable is 
approximately 20 inches.

– The workstation surface should have a minimum depth of 36 inches to 
accommodate distance adjustment.

– Adjust the screen angle to minimize reflection and glare, and avoid highly 
reflective surfaces for the workstation.

� Use a well-designed copy holder, adjustable horizontally and vertically, that allows 
referenced hard-copy material to be placed at the same viewing distance as the 
screen and keyboard.

� Keep wires and cables out of the way of users and passersby.

� Choose a workstation that has a surface large enough for other tasks and that 
provides sufficient legroom for adequate movement.
Manual Overview 1-7
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Overview

About This Chapter This chapter provides a description of the FMAT™ 8100 HTS System, including its 
purpose and function, its components, and how the system collects data.

In This Chapter The following topics are covered in this chapter:

Topic See Page

System Description 2-2

How the FMAT System Measures Fluorescence 2-4
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System Description

Purpose and
Function

The FMAT system includes a detection system, computer, and accompanying 
software.

� The system is designed to image and measure the fluorescent intensity of cells or 
beads in a mix-and-read format.

� The system can scan 96- or 384-well plates for fluorescent events related to 
receptor ligand reactions, apoptosis, immunoassays, and other similar cell-based 
or bead-based assays. 

� The system operates either manually or automatically (robot mode) with a built-in 
robotic plate handler and barcode reader.

Instrument
Components

The FMAT system consists of three components:

� The FMAT instrument

� The robotic plate handler

� The computer

Refer to the following figure for a typical system layout.

Processing Plates
With the Plate

Handler

The FMAT system uses the robotic plate handler to enable high throughput screening. 
The plate handler can sequentially process 96-well or 384-well plates from each of the 
four input racks to the FMAT scanner.

During operation, the plate handler:

� Lifts a plate from the top position of an input rack.

� Passes the plate in front of the barcode reader (if barcode is selected).

� Places the plate in the tray of the FMAT scanner.

� Initiates the device cycle.

� Moves the plate to the output rack after the cycle is complete.

After the plates from the first rack are processed and stored in the output rack, the 
plates can be returned to their original rack using the re-stack option and the next rack 
of plates are processed.
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Data Collection The system uses various run parameters contained in an assay to define the data 
collection. The parameters for a run specify how the instrument and software collect, 
analyze, and display data. 

Experiment Phases Reading a plate on the FMAT system consists of three phases:

� Setup

� Run

� Analysis

Refer to the following table for a description of each phase.

Software Task List The FMAT™ 8100 Analysis Software performs the following tasks:

� Sets up plate information and plate layout

� Sets the run parameters for the instrument

� Collects and analyzes the digital image

Note The software displays the raw data in grayscale, histogram, scatterplot, or psuedo-color 
(not the actual dye-color) image form.

Phase Description

Setup Appropriate parameters are chosen for the assay, and a specific assay is 
selected for the sample run.

Run Specific wells or the entire plate is scanned and displayed.

Analysis Numerical and image data are created. Numerical data and image files can 
be opened and printed by the FMAT software.
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How the FMAT System Measures Fluorescence

Overview A laser beam scans 1 x 1 mm square segments within 100 microns of the bottom of a 
microtiter plate well, exciting the fluorescent dye. The objective lens collects the 
emitted light. Only light emitted near the bottom of the well is collected. Then the 
emitted light is separated into two channels. The bandwidths are:

� 650–685 nm

� 685–720 nm

Each channel has a photomultiplier tube (PMT) that converts the light energy into an 
electrical signal. The electrical signal is digitized by an analog-to-digital converter, and 
the digital data is sent to the host computer over an ethernet connection. This digital 
data is then stored as an image of the fluorescent events captured by the detector at 
the bottom of each well.

Mapping The FMAT instrument maps each individual plate and determines the topography of 
the bottom of the plate. With this map, the z-axis motor adjusts the scanning height 
accordingly for accurate scanning.

Once mapping is complete, scanning of each well begins. Mapping and scanning time 
varies depending on the type of plate being used. 

Note When you set the FMAT system software to re-scan a plate repeatedly, the FMAT 
instrument does not need to remap the plate after the first scan because the plate is not 
removed.

Mapping and Scanning Times

Detector
Components

There are two key components of the detection system:

� The X,Y, Z sample stage

� The optical system

Sample Stage
Function

The function of the X,Y, Z sample stage is to: 

� Move the microtiter plate over the objective lens

� Move the plate to and from the load position 

� Autofocus the scanning laser beam in the Z (up/down) direction

Optical System
Function

The function of the optical system is: 

� To focus and direct the laser beam’s excitation of the fluorescent dyes 

� To efficiently collect the fluorescent emission

� To separate the fluorescent emission into two channels

The mapping and scanning times for different plate types are given below.

96-well 384-well

Mapping Time (min) 1.7 4.2

Scanning Time (min) 4.5 13.2
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Optical System
Components

FMAT Optical
System

The FMAT system’s unique optical platform yields population data in image format 
with excellent quantitative characteristics.

� The microtiter plate bottom is mapped for its topology.

� Dye-labeled cells or beads are excited by a helium neon laser. The laser performs 
250 scans across an area 1mm x 1mm x 100 microns deep in 1 second.

� Two dyes can be used. The emissions of these dyes are collected by two 
photomultiplier tubes and converted to data.

� The FMAT system software processes the data and reports the results as:

– Spreadsheet data

– Two-dimensional image, three-dimensional histogram, scatterplot, and color 
images

The optical system consists of the following components:

Components Function

17-mW, 633-nm red 
helium-neon laser

Light source to excite an appropriate range of fluorescent dyes.

Galvanometer Rotates a mirror that directs the laser beam along a scan line.

Filters Optical filters cut off unwanted lower/higher light wavelengths to 
reduce background fluorescent noise.

Dichroic filters (beamsplitters) allow passage of a range of 
wavelengths of light, while reflecting all other wavelengths. 

Mirrors A scanning mirror deflects the light beam across the sample area. 

Additional mirrors are used for directing the light.

Lenses A 20X objective lens focuses the laser onto the sample and also 
collects the emitted fluorescent light.

Additional lenses are used for focusing the light.

Photomultiplier tube 
(PMT)

Two PMTs amplify and measure the incoming fluorescent light 
signal. The light signal is changed into an electrical signal. 

Photodiode Used to focus during the mapping process.

Confocal aperture Maximizes the signal-to-noise ratio by rejecting autofluorescence 
and scattered light outside the desired sample volume, within the 
microtiter well.

Depth of focus: 100 µm
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Wavelength 

Emission path
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645 nm dichroic
beamsplitter

Scan mirror

Reflector
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Running Samples 3
Overview

About This Chapter This chapter contains procedures for loading and scanning plate(s) on the 
FMAT™ 8100 HTS System. Procedures to run samples using either one plate 
(manual mode) on the scanner tray or multiple plates using the Zymark® Twister™ 
Universal Microplate Handler are described here. 

In This Chapter The following topics are covered in this chapter:

Topic See Page

Overview for Running Samples 3-2

Running a Plate Manually 3-3

Running With the Robotic Plate Handler 3-7

Viewing the Data Collection Process Live 3-11
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Overview for Running Samples

Running Samples The main steps for running samples are:

� Warming up the system components

� Creating a new run

� Loading a plate manually or by using the plate handler

� Scan plates

See the table below for a brief description of what is involved in each command.

Warming Up Power on all components of the FMAT system 30 minutes before use and If the 
instrument has been turned off after continuous use.

Choosing Manually
or With Robot Mode

The Manually or With Robot procedures are quite similar. By selecting With Robot, the 
options involving the plate handler become active.

The procedures that follow are based on using the Default assay. Default conditions:

� Using 96-well plate(s)

� FL1

� Population A

Command Description

Create a New Run � Specify a name for the run and storage location for the data.

� Select manual or robotic plate placement.

� Select the assay you will use to collect and analyze data.

Load Plates � In manual mode, load one plate at a time.

� In robot mode, the automated plate handler processes multiple 
plates.

Scan Plates � The instrument maps each plate to determine the contour and 
topology of the bottom of the plate. The z-axis motor can then 
adjust the scanning height for consistency and accuracy.

� The laser scans each well. The plate matrix in the Run window 
displays the status of each well.

� The Run window allows you to view well data in real time.
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Running a Plate Manually

Creating a  Runfile When starting a new run, you must first create a runfile.

To create a runfile: 

Step Action

1 Launch the FMAT™ 8100 Analysis Software, and log in. If you need more 
information about launching the software and logging in, see “Starting the Software 
for the First Time” on page C-4.

The Run window opens.
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2 From the File menu:

a. Select New Run.

The Create New Run dialog box opens as shown below.

Note Make sure that the assay you want is listed in the Use Assay drop-down 
menu. To review the parameters of the available assays or modify an assay, click 
Assay Manager to open the Assay Manager window. When returning to the Create 
New Run window, check the Use Assay field again. See “Creating Assays” on 
page 5-1 for more information.

b. For this exercise, select Default.

3 Use the Look in drop-down menu to select the folder to store the new run data.

4 For Place Plates, select Manually. 

5 Type the name for the run into the File name text box.

IMPORTANT File or folder names cannot contain most special characters. Do not 
use the special characters: \ / : * ? “ < > | in a file/folder name. The FMAT system 
software will use the file name entered to create a folder by the same name. When 
special characters are used, the sample run fails because the software interprets 
these characters as specific commands and does not create the folder.

Note The software appends “.fmat” to the created file, so files are always named 
according to the format <filename>.fmat.

6 Click Create to close the dialog box.

To create a runfile: (continued)

Step Action
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Using the Run
Window

Check the main window after creating a new runfile. The main changes to notice are 
the:

� Name of the run appears at the very top of the window

� Run button is enabled (turns green)

� Run Properties pane shows the parameters that you selected

Loading Plates
Manually

To load plates manually: 

Step Action

1 Open the scanner door by clicking the  Eject button located on the toolbar.

2 Place the covered plate on the scanner stage so that well position A1 is located in 
the lower-left corner of the stage pointing toward the front of the scanner.

IMPORTANT Use hard plate covers or plastic sealers to protect the samples from 
contamination and evaporation. Do not touch the bottom of the plates because 
fingerprints will affect scanning.

Looking at the plate on the scanner tray from a top view, standing in front of the 
scanner, the plate should be oriented as shown below:

LASER HAZARD. Do not remove the cover of the instrument. 
Exposure to direct or reflected laser light can burn your retina and leave permanent 
blind spots. Never look directly into the laser beam. 

3 Click the Start Run icon( ).

The Enter Plate Name dialog box opens for a manual run.

Option: Rename the plate by typing in another name, avoiding special characters.

A B C D E F G H

1
2

3
4

5
6

7
8

9
10

11
12

G
R

15
34

Well A1 Front of scanner

WARNING!
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Pausing or Stopping
a Run While

Scanning

To pause or stop a run, click the Pause ( ) or Stop ( ) button.

� When you pause a run, the button grays out while the run is being paused. You 
can pause a run only while it is scanning, not while it is mapping. Pause does not 
take effect until the scanning and analysis of the current well is complete. To 
restart, click the Start Run button.

� When you stop a run, the instrument will finish mapping, and then the plate is 
ejected from the instrument. If you want to restart the run for that plate, you have 
to remap and rename the run.

Note The system may continue operation for a few minutes after you click the Pause or Stop 
buttons.

Running Another
Plate

When a manual run has finished, the Enter Plate Name dialog box opens again. By 
default, Plate002 should be in the field.

4 Click OK to the default plate name Plate001.

The plate is loaded and mapping starts.

See “Mapping” on page 2-4 for more information.

IMPORTANT Once mapping starts, it cannot be stopped. The only way to stop is 
to power off the system.

To load plates manually: (continued)

Step Action

To start another plate: 

Step Action

1 Load a second plate on the scanner stage. 

2 In the Enter Plate Name dialog box:

� Click OK to accept the name. The plate is loaded and mapping starts.

� Click Cancel to end the run.
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Running With the Robotic Plate Handler

Selecting Robot
Parameters

Use the plate handler for multiple plate handling. One stack can use:

� 13 plates with lids

� 15 plates with plate sealers

To select robot parameters: 

Step Action

1 Launch the FMAT™ 8100 Analysis Software, and log in. If you need more 
information about launching the software and logging in, see “Starting the Software 
for the First Time” on page C-4.

The Run window opens.

2 From the File menu:

a. Select New Run.

The Create New Run dialog box opens as shown below.

Note Make sure that the assay you want is listed in the Use Assay drop-down 
menu. To review the parameters of the available assays or modify an assay, click 
Assay Manager to open the Assay Manager window. When returning to the Create 
New Run window, check the Use Assay field again. See “Creating Assays” on 
page 5-1 for more information.

b. For this exercise, select Default.
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3 Use the Look in drop-down menu to select the folder to store the new run data.

4 In the Create New Run window under Run Properties, for the Place Plates option, 
select With Robot. The plate handler options are enabled.

Note When With Robot is selected, the Delayed Start option in the Instrument 
menu is enabled. For more information about Delayed Start, see “Setting Delayed 
Start” on page C-8.

5 If you want your plates to be re-stacked after they have been scanned, select 
Restack Afterwards.

6 From the Lid Option drop-down menu, select one of the following options:

� No Lids

� Top Plate Only

� Every Plate

To select robot parameters: (continued)

Step Action
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7 Select the robot stacks you will be using. The stack options are used in this order:

a. Default

b. Ext Stack 1

c. Ext Stack 2

d. Ext Stack 3

8 Type the name for the run into the File name text box.

IMPORTANT File or folder names cannot contain most special characters. Do not 
use the special characters: \ / : * ? “ < > | in a file/folder name. The FMAT system 
software will use the file name entered to create a folder by the same name. When 
special characters are used, the sample run fails because the software interprets 
these characters as specific commands and does not create the folder.

Note The software appends “.fmat” to the created file, so files are always named 
according to the format <filename>.fmat.

9 Click Create to close the dialog box.

To select robot parameters: (continued)

Step Action

GR1732

Output stack

Ext Stack 3

Ext Stack 2

Ext Stack 1

Default (input) stack
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Loading Plates for
Batch Mode

Processing

Pausing or Stopping
a Run While

Scanning

To pause or stop a run, click the Pause ( ) or Stop( ) button.

� When you pause a run, the button grays out while the run is being paused. You 
can pause a run only while it is scanning, not while it is mapping. Pause does not 
take effect until the scanning and analysis of the current well is complete. To 
restart, click the Start Run button.

� When you stop a run, the instrument will finish mapping, and then the plate is 
ejected from the instrument. If you want to restart the run for that plate, you have 
to remap and rename the plate.

IMPORTANT The system may continue operation for a few minutes after you click the Pause 
or Stop buttons.

To load plates for batch mode processing: 

Step Action

1 Place the prepared microplates into the input rack(s).

IMPORTANT Cover the plates to protect against contamination and evaporation. 
Problems may occur with plastic or foil sealers that can cause the plates to stick to 
each other. Make sure these sealers are carefully cut to fit the plate tops with no 
sticky surfaces exposed.

2 Check the orientation of the plates in the racks.

From a top view, well A1 is located on the lower-right side, away from the plate 
reader, as shown in the top-down view below:

3 Click the Start Run icon( ).

The run starts.

A

B

C

D

E

F

G

H

123456789101112

G
R

15
35

Well A1

Barcode label
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Viewing the Data Collection Process Live

Reading the Status
Display

During data collection the following images are presented to indicate progress:

� An unscanned well is gray.

� When the scan is complete and an image file has been created, a black box and a 
circle are displayed in a well.

� When the image has been analyzed and an analysis file has been created, a 
triangle is displayed in the circle. Double-click the triangle to view the data.

Note Because analysis keeps up with collection, the circle and triangle graphics often appear 
at the same time.

IMPORTANT You may not see any immediate change in the Scanning Time Remaining field. 
The field will update after mapping is complete.

If you double-click on a well that has not been scanned yet, you may see an alert box 
message similar to the one shown below.
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Viewing Grayscale
Images

Other Views To see the data displayed in other formats, click the tabs:

� Histogram

� ScatterPlot

� ColorPlot

For more information about the live Sample Detail displays, see “About the Sample 
Detail Window” on page A-10.

To view the results of an analyzed well while data is being collected: 

Step Action

1 Double-click the triangle in the well of interest (e.g. A1, B3, etc.). You can also 
right-click on the well of interest to open the Well Detail menu.

The Sample Detail window opens to the Grayscale tab.

2 To display the data being collected in real-time, select the check box for Show Live 
Collection. Make sure that the plate you are scanning is in the Plate drop-down list.

Note Do not use the sample detail window during long batch runs if you are not 
planning to view the data.

The image below shows the results for well D9.

3 To view other scanned wells, click on the well of interest in the Plate grid.

√
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Viewing and Reanalyzing 
Data 4
Overview

About This Chapter This chapter shows several files that can be viewed to analyze your runfile data. An 
option is to reanalyze the data by using the Analysis Properties wizard described 
here.

In This Chapter The following topics are covered in this chapter:

Topic See Page

Looking at Folder and File Structure 4-2

Viewing Different Data Files 4-5

Reanalyzing a Run 4-9

Optimizing Data 4-12
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Looking at Folder and File Structure

How Data is Stored The FMAT™ 8100 Analysis Software version 2.0 stores the collected data from each 
run in a single run folder. By default, the folder is given the same name as that of the 
run.

As shown above, the run folder contains these elements:

� An Analysis folder

� An images folder

� A listmode folder

� A log folder 

� A runfile, ending in “.fmat”

About the Analysis
Folder

The Analysis folder contains all the analysis data within subfolders. There is one 
subfolder for each analysis. The first analysis has a subfolder with “001” added to the 
name. Subsequent analyses are given subfolders with sequential incremental 
numbers.

Analysis 001 Subfolder Showing File Types

Each subfolder contains:

� One assay file (assay.cxp) giving the analysis parameters that were used.

� One or more plate results files (<platename>.cxr) giving the analysis data. The 
data is sorted by population and each line represents one well.

� One run result file (plateview.cxr), giving numeric results in a format matching the 
plate layout.

– 8 x 12 for 96-well plates

– 16 x 24 for 384-well plates
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About the Listmode
Folder

The listmode folder contains one subfolder for each scanned plate. The subfolder(s) is 
named after the plate. Each subfolder contains listmode files for each scanned well.

Listmode 001 Subfolder Showing File Types

Listmode files are named according to a scheme that gives the well location for each 
file:

� AnaNNxAA.cxa, where

– NN is the plate column

– AA is the plate row

For example, a file named Ana03x0D.cxa contains data from a well in column 3 and 
row D. See “Listmode.cxa” on page 4-7 to view a listmode.cxa file.

About the Images
Folder

The Images folder contains one subfolder for each scanned plate. The subfolder(s) is 
named after the plate. If a plate is scanned multiple times, each subfolder has a 
two-digit number added to the name that is incremented sequentially.

An images subfolder contains one image file per scanned well. The image files are 
named according to a scheme that gives the well location for each file:

� ImgNNxAA.cxi, where

– NN is the plate column

– AA is the plate row

For example, a file named Img03X0D.cxi contains image data from a well in column 3 
and row D.
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About the Runfile The runfile contains information that allows the FMAT system software to find all 
supporting folders and files. Therefore, this is the file that you select when opening a 
run.

IMPORTANT Do not change the location of the runfile, or the software will not be able to find 
the associated folders.

About the Log
Folder

The Log folder contains subfolders for recent days’ runs. The subfolders are named 
according to the following scheme:

� YYYYMMDD, where

– YYYY is the year

– MM is the month

– DD is the date

Each subfolder contains log files with instrument and run conditions for each plate run 
on a particular day. The log files are named according to the following scheme:

� YYYYMMDD_xx.log, where

– YYYYMMDD is the same as the name of the subfolder

– xx is a two-digit number added to the name that is the hour

For example, a file named 20000122_15.log was run on January 22, 2000 at 3 pm.
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Viewing Different Data Files

Selecting a Data File
to View

The table below lists the files available to study data in the run folder.

Files to View Data 

File View for... Layout How to Access

Plateview.cxr � Grid view of the data for 
all the plates in your run.

� Derived parameters 
(calculations).

� Multiplex assay results. 

� Data representing all of 
the plates in one run.

� Plate grid where the 
column and row position 
represents the plate well 
position. 

� Data is sorted using the 
parameters you selected 
either in Plate Analysis or 
Reanalysis Manager. See 
“Using the Plate Analysis 
Window” on page 5-12 or 
“Reanalyzing the Run” on 
page 4-10.

Using the system software:

� From File, select View 
Run Results in Helper. 
(This will open in 
Microsoft® Excel if linked 
in FMAT system 
software’s Options. See 
“Setting Options” on 
page C-7.)

Using the Browser:

� From the Run Folder, 
select Analysis Folder. 
Click Plateview.cxr. 
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<Platename>.cxr a tabular format of the data. � Data representing the 
whole plate.

� Same column and row 
names from plate to 
plate.

Using the system software:

� Select Table Tab.

� From File select View 
Plates in Helper. (This will 
open in Excel if linked in 
FMAT system software’s 
Options.)

Using the browser:

� From the Run Folder, 
select Analysis Folder. 
Click <platename>.cxr. 

Files to View Data (continued)

File View for... Layout How to Access

The <Platename>.cxr File and Table Tab Column Headings 

Column Heading Description

Plate Name or ID of the plate.

Row Plate row position of the well.

Col Plate column position of the well.

Pop Population name for a data row.

Count Number of events in the well.

GatedCount The number of events in the well as determined by the Min Count 
option. See the note about Min Count on page 5-12 for more 
information.

FL1 The average intensity of the fluorescent events in PMT1.

FL2 The average intensity of the fluorescent events in PMT2.

Color The average FL2/FL1. This is indicative of the dye associated with the 
individual cell or bead.

Size The average full width at half max in the X dimension times that in the Y 
dimension.

Fit A measure of smoothness. This determines how well an event’s shape 
must fit a spline to be considered in a statistical analysis. The range is 0 
to 1, where a value closer to 0 is a better fit.
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Listmode.cxa a detailed summary of the 
attributes of individual 
events. 

These are files of each 
scanned well where one row 
represents one event.

Using the system software:

� From File, select View 
Well Listmode in Helper. 
(This will open in Excel if 
linked in FMAT system 
software’s Options.)

Using the browser:

� From the Run Folder 
select listmode Folder 
Click<platename>.cxa. 

Files to View Data (continued)

File View for... Layout How to Access

.cxa File Column and Description Headings 

Column Heading Description

Peak Numeric identification of the fluorescent event.

x(1) Location of the fluorescent event in PMT1 along the x-axis.

y(1) Location of the fluorescent event in PMT1 along the y-axis.

xFWHM(1) The full-width half max of the fluorescent event in PMT1 along the x-axis is 
proportional to the size of the fluorescent cell or bead. 

yFWHM(1) The full-width half max of the fluorescent event in PMT1 along the y-axis is 
proportional to the size of the fluorescent cell or bead.

fit(1) A measure of smoothness of the events detected by PMT1. This determines how 
well an event’s shape must fit a spline to be considered in statistical analysis. The 
range is from 0–1, where a value closer to zero is a better fit.

FL(1) The fluorescence intensity of the fluorescent event in PMT1.

x(2) Location of the fluorescent event in PMT2 along the x-axis.

y(2) Location of the fluorescent event in PMT2 along the y-axis.

xFWHM(2) The full-width half max of the fluorescent event in PMT2 along the x-axis is 
proportional to the size of the fluorescent cell or bead.

yFWHM(2) The full-width half max of the fluorescent event in PMT2 along the y-axis is 
proportional to the size of the fluorescent cell or bead.

fit(2) A measure of smoothness of the events detected by PMT2. This determines how 
well an event’s shape must fit a spline to be considered in statistical analysis. The 
range is from 0–1, where a value closer to zero is a better fit.

FL(2) The fluorescence intensity of the fluorescent event in PMT2.

Ratio FL2/FL1. Is indicative of the dye associated with the individual cell or bead.
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Other File Options See “Displaying Data” on page A-3 for more information about the Plate Tab, Table 
Tab, Scatterplot Tab, and 3D data.

See “About the Sample Detail Window” on page A-10 for more information on viewing 
Grayscale, Histogram, Scatterplot, and ColorPlot data.
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Reanalyzing a Run

Overview The instrument provides the option to reanalyze run data if you want to:

� Adjust and optimize assay parameters.

� Edit plateview parameters to produce different outputs.

Changing Run Data There are two categories of data that cannot be changed for the reanalysis of your raw 
data:

� The photomultiplier tube (PMT) Gains (shown in the Instrument window). PMT 
gains can be changed only prior to the scan because they determine the actual 
collection of data. 

� The Assay Name (shown in the Name window). The Assay Name cannot be 
changed because this would modify the saved assay.

Changing Analysis
Parameters

Before changing analysis parameters, review your data to determine what changes 
you need to make. You can:

� Open a plate, and double-click a well to open the Sample Detail window. In the 
Scatterplot tab, you can view the data from the selected well.

� Open the Analysis folder for your run, then open the plateview.cxr file.

Opening a Run To open an existing run: 

Step Action

1 From the File menu, select Open Run or click the Open Run Document button (  ).

The Open Run dialog box opens.

2 From the Look in drop-down menu, select the folders containing your FMAT run 
files.

3 From the list of folders and files, select the .fmat run file that you want, and click 
Open.

The run opens.

4 Select a plate to view from the left side Plates pane in the main run window.
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Reanalyzing the Run

Note For a reanalysis, you cannot change settings in the Instrument window or the Assay 
Name window.

To reanalyze data while a run is open: 

Step Action

1 From the Tools menu, select Reanalyze, or click the Reanalyze button (  ).

The Analysis Properties wizard for the current run opens with Instrument 
highlighted.

This wizard functions in the same way as the New Assay wizard, except that it 
contains the values of the assay that was originally selected. See Chapter 5, 
“Creating Assays,” for more information on the New Assay wizard.

2 Step through the wizard using the Next and Previous buttons, and make your 
changes to the assay parameters:

� In Define Gates, you can click a plate well, and the data will display in the graph. 
Populations can be analyzed and new parameters can be set.

� In Define Gates and in Define Populations you can optimize data by choosing 
different parameters.

Note You can also go directly to a specific window by clicking on the name in the 
left pane.

3 When done, click Reanalyze, and the reanalysis begins.

Folders containing the reanalyzed data are created in the analysis folder. The 
Folder name is appended with 001, 002, etc.
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Reanalyzing in the
New Software

Data collected under the older version 1.0 software may be reanalyzed in the 
FMAT 8100 Analysis Software version 2.0. You will use the import function.

To reanalyze a run in the FMAT 8100 Analysis Software version 2.0: 

Step Action

1 From File select New Run. 

The Create New Run dialog box opens.

2 a. For File name type: Import (or file name of choice)

b. Select the appropriate assay.

c. Click Create.

The main run window opens.

3 From File select Import Plates. 

The Select the FMAT v 1.0 RunDoc.txt file window opens.

4 a. Navigate to the desired run folder that you want to import.

b. Open the run document folder.

c. Select RunDoc.text file.

5 Click Open. 

The Plate Tab window shows the progress of importing and analyzing the wells.
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Optimizing Data

Analyzing PMT
Values

To verify whether the PMT settings are appropriate, check several wells of a sample 
plate with positive and negative controls and analyze the data. The quality of the 
results can be analyzed by viewing scatterplots.

Note In Well set-up, deactivate the wells that are not in use.

To view scatterplots of the fluorescence values: 

Step Action

1 Click the Plate tab in the run window.

2 Select a well to view and double-click it. The Sample Detail window for that well 
opens.

3 Select the Scatterplot tab.

4 Select FL1 for one axis and FL2 for the other.

5 Interpret the graph results: the majority of the data points should display in a linear 
fashion. The ratio of this line is dependent on the fluorescent dye used.

If... Then...

the graph result is linear (as 
shown below)

the PMT values are appropriate.

If... Then...

the graph result is nonlinear (as 
shown below) where points do 
not fall on a line at the highest 
fluorescent values

a. either one or both of the PMTs are 
saturated and offscale. Reset the 
PMTs to a lower setting.

b. Rescan the well.

Good, as 
shown by the 
linear result 

Not Good.
FL1 or PMT1 is 
saturated. 
Try lower PMT 
values in 
increments of 
about 50.
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Viewing Color
Values

To view color values: 

Step Action

1 Select the Scatterplot tab of the Sample Detail window.

2 From the x-Axis pull-down list, select Color.

From the y-Axis pull-down list, select Event #.

Expected results show points clustered around the color value of that dye. 
Randomly scattered points would indicate that the color value is a poor fit. 

The figure below shows clusters around 1 and 0.2 as reasonable color values for 
this bead set containing two dyes in the well. 
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Creating Assays 5
Overview

About This Chapter This chapter contains information about using the Assay Manager in the FMAT™ 8100 
Analysis Software. Information is provided for all the windows, commands, and 
buttons including:

� Assay Tools

� Image Analysis Settings

� Data Analysis Settings

� Plate Settings

In This Chapter The following topics are covered in this chapter:

Topic See Page

Assay Tools 5-2

Image Analysis Settings 5-4

Data Analysis Settings 5-7

Plate Settings 5-14
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Assay Tools

Overview The central concept to FMAT analysis is the assay. The New Assay Wizard allows you 
to design assays with different parameters for different purposes. The Assay Manager 
allows you to save and organize your assays into folders. You can then select any 
assay from your folder(s) for a run.

Opening the Assay
Manager

You can open the Assay Manager in different ways, depending on what you are 
currently doing in the FMAT system software.

� From the Create New Run dialog box

� From the Tools menu

� From the keyboard by pressing the Control and letter M keys (Ctrl+M) 
simultaneously

The Assay Manager
Window

The Assay Manager contains all the saved assays. When you first open the system 
software, the only assay present is the default assay. As you define and add new 
assays, you can organize them into folders as shown below.

IMPORTANT Do not delete the default assay. All new assays are based on the default assay 
set at installation by the field service engineer.

Refer to the following table for information about the buttons in the menu bar.

Menu Bar Buttons 

Button Name Action

New Folder Creates a new folder.

Delete Folder Deletes a selected folder once you have deleted all assays 
within that folder.

New Assay Opens the Assay Manager using the Default assay and creates 
a new assay.

Edit Assay Opens the Assay Manager using the selected assay and allows 
you to make changes.

Copy Assay Makes a copy of the selected assay.

Delete Assay Deletes the selected assay if you are the Administrator or the 
creator of that assay.
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Using the New Assay
Wizard

The New Assay Wizard steps you through all the parameters needed to define an 
assay. The New Assay Wizard is divided into three categories:

� Image Analysis

� Data Analysis

� Plate Settings

To create or edit an assay, click Next as you progress through all the windows of the 
wizard, then click Finish to close the New Assay Wizard. Your assay is saved and you 
can see it in the Assays folder of the Assay Manager.

Opening the
New Assay Wizard

To open the Assay Wizard: 

Step Action

1 From the Tools menu, select Assay Manager.

2 In the Assay Folders pane on the left, click the Assays folder.

All the buttons become enabled and the default assay appears in the Contents pane 
on the right.

3 Open the New Assay Wizard. In the Assay Manager window:

� Click the New Assay button( ) or

� From the File menu, select New Assay.

The New Assay Wizard opens with Instrument highlighted. 
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Image Analysis Settings

Overview In the Assay Manager, there are two windows in the Image Analysis category:

� The Instrument window

� The Image Analysis window

Using the
Instrument Window

The Instrument window allows you to specify the instrument conditions, such as:

� Change PMT (photomultiplier tube) Gains settings. 

� Select the type of plate you are using. You might select 384 Well FMAT or 96 Well 
FMAT.

Note The default and factory settings in this window are entered by your service engineer 
during system installation and are unique to each instrument.

About PMT Values IMPORTANT The PMTs are critical data collection tools and must be set correctly so that dye 
is detected without saturating the PMT. We strongly recommend that you use the PMT values 
that have been set by your service engineer.

Changing PMT Settings

Because PMT1 and PMT2 are different mechanically, they are not collecting light 
signal equally. The ratio has been adjusted at the factory to compensate for the 
difference. 

IMPORTANT We strongly recommend that the relative PMT settings remain constant.
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Retaining the
Correct PMT Ratios

Changing the
Settings

Selecting the
Plate Type

To retain the correct PMT ratios: 

Step Action

1 Click the Use Factory Settings button to invoke the factory setting.

2 Select the PMT Voltage Lock using the drop-down menu.

3 Now you need only adjust one PMT, and the other will automatically be adjusted 
with it while retaining the correct relative value. 

To change the settings:

Step Action

1 Place the cursor over the slider for the PMT setting you want to change.

2 While holding down the left mouse button, move the slider to the value you want.

Note For finer control, use the right and left arrow keys on your keyboard.

To select the plate type: 

Step Action

1 Click the down arrow to the right of the Plate Type box to open the drop-down menu.

2 Select the correct plate type from the list.

3 When done, click Next to proceed to the next window.
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Image Analysis
Window

In the Image Analysis window you set the threshold for the recognition of an event 
based on the number of standard deviations difference between the intensity of the 
event and the background baseline.

Note As different algorithms become available, they will appear in the “Analyze using” 
drop-down menu at the top of the Image Analysis window.

Changing the
Intensity Threshold

To change the intensity threshold: 

Step Action

1 In the Image Analysis window, place the mouse cursor over the slider.

2 While holding down the left mouse button, move the slider to the value you want. 
You can also use the right and left arrow keys on your keyboard to change the 
setting.

Note The default setting of 3 should be used for most assays.

3 When done, click Next to proceed to the next window.
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Data Analysis Settings

Overview The Data Analysis category of the New Assay Manager has four windows:

� Define Gates

� Define Populations

� Outlier Analysis

� Plate Analysis

Using the Define
Gates Window

In the Define Gates window you choose a parameter and then define the gates for that 
parameter. The parameters available in this window are described below. 

Parameters Description

FL1 The average fluorescent intensity of the fluorescent events in PMT1.

FL2 The average fluorescent intensity of the fluorescent events in PMT2.

Color The average FL2/FL1.

This is indicative of the dye associated with the individual cell or bead.

Size The average full width at half max of the fluorescent peak in the x 
dimension times that in the y dimension.

Fit A measure of smoothness. 

This determines how well an event’s shape must fit a spline to be 
considered in a statistical analysis. The range is 0 to 1, where a value 
closer to 0 is a better fit.
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Define Gates
Window

When you select Define Gates, the Specify the Gates window opens. 

Clicking any of the Parameter check boxes changes the Gate Selection window to 
show the gate settings for that parameter.
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Selecting Parameters
and Defining Gates

You must select at least one parameter before you can move on to the next window. 
Use FL1 and define PopA as all events for the default assay.

Note You can color-code each gate for easier viewing:

a. For each gate, click the color tile box next to the name field at the bottom of the window.

b. When the color selection window opens, click a color square to select it, then click OK to 
close the window.

To select a parameter and define the gates: 

Step Action

1 In the small inset window placed under Specify the Gates shown on page 5-8, check 
the box(es) next to the parameter(s) you want to select:

� FL1

� FL2

� Color

� Size

� Fit

The graph in the selection window has two lines to represent numerical values that 
you select and move to define gates, allowing up to three distinct populations.

Note You can also simply click the name of the parameter to view the gate 
selection window for that parameter.

2 To alter the value of a gate, place your cursor over the line on the graph for that gate 
until the cursor turns into a double arrow. 

3 Hold down the left mouse button and move the line until you see the value you want 
in the text box for that gate.

Note You can use the Up and Down arrow keys on your keyboard for finer 
adjustment. You can also type in the value by selecting the textbox and typing in a 
new value and press Enter.

4 Option:

Name each gate.

a. At the bottom of the graph, click on the name you want to change.

b. Type in the new name. This is the name that will be used in the following 
windows.

IMPORTANT Do not use the following special characters in a name: / \ : “ ? * < > |

5 When done, click Next to proceed to the next window.
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Combining Gates
Into Populations

In the Define Populations window, you select gated parameters to group events into 
distinct populations. Based on the names you assigned when setting the gates, check 
the boxes to determine which populations contain the gated parameters you want. 
Raw data is filtered using the gates, and the final output data is what you select.

The example below shows that the user has chosen FL1 Dim, Medium and Bright 
events to be included in Population A.

Note As plug-ins become available, they will appear in the “use” drop-down menu at the top of 
the Define Populations window. 

Selecting and
Defining Populations

To select and define populations: 

Step Action

1 Under PopulationA, check the box for the parameter you want to use to define this 
population. Refer to the examples shown above.

2 If you want to define additional populations, check a parameter for each additional 
population.

3 To change the name of a population, double-click the name in the title bar, then type 
in the new name.

IMPORTANT Do not use the following characters in a name: / \ : “ ? * < > |

4 When done, click Next to proceed to the next window.
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Using the Outlier
Analysis Window

In the Outlier Analysis window, you set the limits for a population using the slider bar to 
set the number of standard deviations from the median value. Any events that occur 
outside of the number of standard deviations you set are then considered to be 
outside of the population (outliers) and are not included in the final output.

By default, FL1 is always selected. If none of the boxes are selected, outlier analysis 
will not be done.

Note As plug-ins become available, they will appear in the “Analyze using” drop-down menu 
at the top of the Outlier Analysis window.

Specifying Outlier
Settings

To specify outlier settings: 

Step Action

1 In the small inset window at the top left of the Outlier Analysis window, check the 
box(es) next to the measurement(s) you want to select.

2 Using the slider at the right side of the inset window, set the number of standard 
deviations from the mean beyond which you consider an event to be an outlier. 

This setting applies to all parameters that are checked.

Note The default value is three standard deviations.

3 When done, click Next to proceed to the next window.
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Using the Plate
Analysis Window

In the Plate Analysis window, you select the parameters that are used in producing the 
output results. In the upper half of this window, you select the parameters that you 
want to report in grid format for each population. You use the lower half of this window 
to specify an analysis formula. Your selection in this window defines the output as 
seen in the plateview file. See “Plateview.cxr” on page 4-5 on how to access this file.

By default, PopA FL1 is selected. If none of the boxes are selected then plate analysis 
(plateview file) will not display data but the Table Tab will show data.

Note As plug-ins become available, they will appear in the “Analyze using” drop-down menu 
at the top of the Plate Analysis window.

Specifying Plate
Analysis Settings

To specify Plate Analysis settings: 

Step Action

1 Select the check box for the parameter(s) that you will be reporting for each 
population. The software creates a data output in plate grid format for each selected 
parameter.

Note The Min Count parameter is used to set the FL1, FL2, color, size, fit and 
count values to zero for wells that have less than the specified number of events 
(e.g., 10).
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2 a. Place a check mark in the Include a Derived Result box.

b. Place a check mark in the Point and Click Entry of Formula Value.

c. In the Result Formula text box, enter the formula for the Derived Parameter Name. 
Alternatively, you can click on the cell of the population you want to use, then 
enter the action you want to take.

The Derived formula is used to output data using a mathematical calculation 
dependent on two parameters in one population or between two populations using 
Reverse Polish Notation (RPN). So, for example, the formula PopA / PopB * 100 
appears as PopA:FL1 PopB:FL1 / 100 *. (For more information about RPN, go to 
http://www.hpmuseum.org/rpn.htm.)

Note Right-click in the Formula text box to view an editing menu. You can also use 
the editing keyboard shortcuts (see Appendix B, “A Tour of the Menus”.)

3 Select the check box for Create Separate Files if you want a file produced for each 
checked parameter. 

Note The software always creates a file (plateview.cxr) with all of the parameters.

To specify Plate Analysis settings: (continued)

Step Action
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Plate Settings

Overview The Plate Settings category of the New Assay Manager is used to specify active wells 
and create naming schemes. The Plate Settings category has three windows:

� Well Setup

� Plate Naming

� Name

Using the Well Setup
Window

In the Well Setup window, you designate wells that are not in use. All remaining wells 
in your plate are unknown (sample) wells. The scanner will only collect data for the 
wells you designate as unknown.

The well designations are:

� Black wells are in use.

� Grey wells with an X are not in use.

Designating Wells To designate wells: 

Step Action

1 a. Select a well by clicking it.

b. Select multiple wells by:

� Dragging the cursor across the wells you want, or

� Press and hold the Control key (Ctrl) while clicking non-contiguous wells

2 Click the down arrow to the right of the Sample Type box to open the drop-down 
menu. 
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Using the Plate
Naming Window

In this window, you set the naming scheme for your plates. If you are setting up assays 
that require repeat scans, as for kinetic studies, you set the parameters in this window.

\

Naming and Repeat
Scanning Plates

3 Select Not in Use as needed.

Note All wells are designated active unless you change their designation.

4 When done, click Next to proceed to the next window.

To designate wells: (continued)

Step Action

To name plates and set repeat scanning: 

Step Action

1 For a robotic run, select the plate-naming method you want to use. (For a manual 
run, you are always prompted to enter a name for each plate.) The robotic run 
plate-naming options are:

� Numerically, prepending run name

� Numerically, prepending the following prefix

� Robot will scan barcode for plate name

Note If you select the second option, be sure to type in the prefix that you want to 
use.
Creating Assays 5-15



Using the Name
Window

In this window, you assign a unique name to the assay you have just created or 
modified.

Note When editing an existing assay, the Assay Name text box displays the assay name but is 
deactivated so that you cannot change the name.

2 Set the repeat scanning options.

a. Select the check box for Scan Plate Repeatedly.

b. Type in the number of times you want the plate to be scanned.

c. Type in the time interval you want to use. Measure from the start of the first plate 
to the start of the second plate.

Note There is a minimum time between each scan. The software estimates this 
time based on the mapping and scanning time for the full plate.

3 Be sure the check box for Scan Plate Repeatedly is clear if you do not want repeat 
scanning.

4 When done, click Next.

To name plates and set repeat scanning: (continued)

Step Action
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Naming Assays To name the assay: 

Step Action

1 In the Assay Name text box, type a descriptive name.

2 If desired, add your comments to the comment text box.

Note Right-click in the comment text box to view an editing menu. You can also 
use the editing keyboard shortcuts. See Appendix B, “A Tour of the Menus” for more 
information.

3 When done, click Finish to close the New Assay Wizard and save your assay.

Your assay is now listed in the Contents page of the New Assay Wizard.

4 Click Done to exit the Assay Manager. 

You are now ready to start a run.
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6
Troubleshooting 6
Overview

About This Chapter This chapter provides detailed information about occasional problems that you may 
encounter when using the FMAT™ 8100 HTS System. Symptoms that you may 
observe and suggested solutions are described. 

In This Chapter The following topics are covered in this chapter:

Topic See Page

Common Problems 6-2

Changing Fuses 6-4

Monthly Equipment Maintenance 6-6
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Common Problems

Problems and
Solutions

Below are common problems with the most likely solutions:

Observation Possible Solution

Well images are blurry or blank. Make sure beads are settled for a minimum 
of four hours.

Make sure there is no condensation or 
fingerprints on the bottom of the plate(s).

You cannot connect to the scanner. � Check the cables and ethernet 
connection.

� Check that no other software is 
communicating with the instrument by 
checking the task bar.

� Check that power is on to all components.

The plate handler and/or barcode reader is 
not operational.

� Check that power is on to all components.

� Check that appropriate selections have 
been made in the FMAT system software. 
See “Running With the Robotic Plate 
Handler” on page 3-7.

� Power off the system. Restart the plate 
handler, the FMAT scanner and lastly, the 
software.

There is a non-linear comparison of FL1 and 
FL2. 

Check the PMT values. Refer to “Optimizing 
Data” on page 4-12.

The image display is too bright or dark. Adjust the intensity control. See “Grayscale 
Display” on page A-11.

Samples are being contaminated or are 
evaporating.

Use lids or plate sealers to protect prepared 
plates.

The scanner goes offline during mapping. The data drive is full.

Wells appear white during scanning. There is too much unbound dye.

One or more components experiences a 
power loss.

Fuse(s) may need to be replaced. See 
“Changing Fuses” on page 6-4.

There is a highly fluorescent sample with 
events appearing larger than expected and 
very uniformly bright.

Rescan the plate with a lower PMT setting.

There is a low signal fluorescent sample 
where events are very dim, the image 
background is black and no (cells) are 
detected.

Rescan the plate with a higher PMT setting.
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Inactivating the
Screen Saver

Screen savers should not be active while running the FMAT™ 8100 Analysis Software 
when connected to an FMAT instrument. If necessary, use the Microsoft® Windows 
NT® Display Properties dialog box to turn off the screen saver. 

To turn off the screen saver:

1 From the Start menu, select Settings, then Control Panel.

2 Double-click the Display icon. 

The Display Properties dialog box opens.

3 Select the Screen Saver tab.

4 In the Screen Saver text box, select (None).

5 Click OK.
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Changing Fuses

About the Fuses Loss of power to the FMAT scanner and/or the Zymark® Twister Microplate Handler 
may be caused by blown fuses. 

Determine the cause of any power overload before replacing blown fuses.

Changing Scanner
Fuses

The scanner uses two 5-Amp Type T fuses, size 5 x 20 mm.

Tool needed to change the fuses:

� A small, flat-blade screwdriver

ELECTRICAL SHOCK HAZARD. Severe electrical shock, which could cause 
physical injury or death, can result from working on an instrument when the high voltage power 
supply is operating. To avoid electrical shock, disconnect the power supply to the instrument, 
unplug the power cord, and wait at least 1 minute before working on the instrument.

CAUTION!

To change the scanner fuses: 

Step Action

1 Put the scanner power switch in the off position and unplug the instrument.

ELECTRICAL SHOCK HAZARD. Disconnect the power cord to 
the scanner before changing the fuses.

2 Use the flat-blade screwdriver to gently pry open the fuse cover. 

3 Remove the red fuse block assembly containing the fuses.

4 Replace the fuses. Be sure the fuses are seated securely.

IMPORTANT Replace the blown fuses only with the fuses of the same type and 
rating.

5 Slide the fuse block back into position.

6 Snap the fuse cover securely into place.

WARNING!

WARNING!
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Changing Plate
Handler Fuses

The plate handler uses two types of fuses:

� There is one 1.5-Amp fuse for 120 V operation. 

� There are two 0.8-Amp fuses for 220/240V operation.

ELECTRICAL SHOCK HAZARD. Severe electrical shock, which could cause 
physical injury or death, can result from working on an instrument when the high voltage power 
supply is operating. To avoid electrical shock, disconnect the power supply to the instrument, 
unplug the power cord, and wait at least 1 minute before working on the instrument.

Tools needed to change the fuses:

� A small, flat-blade screwdriver.

� A small, Phillips-head screwdriver.

Refer to the following table for information on how to change the fuses.

To change the plate handler fuses: 

Step Action

1 Put the plate handler power switch in the Off position and unplug the instrument.

ELECTRICAL SHOCK HAZARD. Disconnect the power cord to 
the scanner before changing the fuses.

2 Use the flat-blade screwdriver to gently pry the cover/fuse block assembly away 
from the power entry port housing. 

3 Remove the cover/fuse block assembly containing the fuse.

a. Loosen the Phillips-head screw on the pedestal by two turns.

b. Remove the fuse block by sliding it up and away from the screw and pedestal. 
There is one holder for the 1.5-Amp fuse on one side and the two holders for the 
0.8-Amp fuses on the other.

4 Be sure the fuse is the correct type and is seated securely.

IMPORTANT Replace blown fuses only with the fuses of the same type and 
rating.

5 Slide the fuse block back into position and tighten the screw. Make sure the new 
fuse(s) faces out.

6 Slide the cover/fuse block assembly back into the housing.

7 Snap the block assembly securely into place.

WARNING!

WARNING!
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Monthly Equipment Maintenance

Plate Handler Clean the: 

� Base and arm surfaces using a water-dampened cloth or sponge. 

� Gripper pads using a lint-free cloth dampened with isopropanol.

CHEMICAL HAZARD. Isopropanol is a flammable liquid and vapor. It may 
cause eye, skin, and upper respiratory tract irritation. Prolonged or repeated contact may dry 
skin and cause irritation. It may cause central nervous system effects such as drowsiness, 
dizziness, and headache, etc. Please read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and gloves.

Computer Checklist The following tasks are recommended procedures for the computer:

WARNING!

√ Description

Back up or archive your data files.

Verify if there is enough space on the hard drive.

De-fragment the hard drive.
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7
FMAT 2-Color Tutorial 7
Overview

About This Chapter This chapter provides a tutorial for the use of the FMAT™ 8100 HTS System and 
demonstrates how to set up, run, and analyze a two-color experiment.

In This Chapter The following topics are covered in this chapter:

Topic See Page

Using the Two-Color Bead Assay 7-2

Materials Supplied 7-3

Materials Required but Not Supplied 7-4

Setting Up the Assay 7-5

Setting Up the Run Parameters 7-7

Running the Instrument 7-13

Viewing the Data 7-14

Troubleshooting 7-17
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Using the Two-Color Bead Assay

About the
Two-Color Bead

Assay

The FMAT™ Two-Color Standard Microsphere Kit (P/N 4316618) uses two sets of 
beads that each contain a different dye. Each set of beads comes in four intensities, 
ranging from high (1) to low (4).

The Two-Color Kit demonstrates how to view and analyze two-color assays.

About Intensity
Levels

Each tube in the kit is labeled with the intensity level of the dye. Each tube is also 
labeled with a relative intensity value. The highest intensity level, Intensity 1, is always 
100% relative intensity.

The relative intensity is determined by flow cytometry. While this correlates closely 
with the value determined in the FMAT instrument, it is not identical.

PMT Channels The FMAT instrument has two photomultiplier tubes (PMTs) and each represents a 
different color channel. A graphical representation is given below.

� Dye A is detected mainly in Channel 1, with some detection in Channel 2. 

� Dye B is detected almost equally in Channel 1 and Channel 2.

About PMT
Channels and Image

Windows

Each image window corresponds to a PMT channel. So, for example, when viewing 
Dye A events, the Dye A events are much brighter in Channel 1 (left window) than in 
Channel 2 (right window), because Dye A emission is collected primarily in Channel 1.

650

PMT 1

In
te

ns
ity

Wavelength

685 720
nm

PMT 2
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Materials Supplied

Kit Contents The FMAT™ Two-Color Standard Microsphere Kit (P/N 4316618) contains eight vials 
of colored beads as follows:

� Dye A (red cap)

– Intensity 1 (highest, 100%)

– Intensity 2

– Intensity 3

– Intensity 4 (lowest)

� Dye B (purple cap)

– Intensity 1 (highest, 100%)

– Intensity 2

– Intensity 3

– Intensity 4 (lowest)

Each kit contains sufficient beads to run ten 96-well plates.

Note Cap colors do not correlate with the colors used to visualize two-color data in the FMAT 
software.

Storage and Stability The Two-Color Kit is stable for one year when stored under the following conditions:

� Undiluted

� 4 °C

� In the dark
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Materials Required but Not Supplied

Materials Supplied
by the User

The following materials are required but not included with this kit:

Item Source

FMAT 8100 HTS System Applied Biosystems

Ten 96-well FMAT plates Applied Biosystems (P/N 4308776)

0.2-µm filtered deionized water Major Laboratory Supplier (MLS)

Twelve 1.5-mL Eppendorf tubes MLS

1000-µL micropipettor MLS

1000-µL micropipettor tips MLS

200-µL micropipettor MLS

200-µL micropipettor tips MLS

Tube rack MLS

Vortex mixer MLS
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Setting Up the Assay

Preparing the Beads You prepare the colored beads for the assay by diluting them as outlined below. You 
will analyze each color of bead separately, and combine them for the multiplex portion 
of the assay.

To prepare the beads for the assay: 

Step Action

1 Label 12, 1.5-mL Eppendorf tubes:

� Tubes A1–A4 are four intensity levels of Dye A

� Tubes B1–B4 are four intensity levels of Dye B

� Tubes AB1–AB4 are four intensity levels of Dye A + Dye B

2 Add 900 µL of deionized water to each Eppendorf tube.

3 Vortex the colored beads for 3–5 seconds to resuspend.

4 Add the beads to each Eppendorf tube as follows:

Tube 
number Beads Intensity

Volume
(µL)

A1 Dye A 1 100

A2 Dye A 2 100

A3 Dye A 3 100

A4 Dye A 4 100

B1 Dye B 1 100

B2 Dye B 2 100

B3 Dye B 3 100

B4 Dye B 4 100

AB1 Dye A + Dye B 1 50 + 50

AB2 Dye A + Dye B 2 50 + 50

AB3 Dye A + Dye B 3 50 + 50

AB4 Dye A + Dye B 4 50 + 50
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Filling the Plate To fill the 96-well plate: 

Step Action

1 Vortex the Eppendorf tubes briefly to mix.

2 Dispense 100 µL of the bead mixture from each Eppendorf tube into the wells of 
the corresponding column of the 96-well plate.

IMPORTANT Be sure to use the FMAT optical plate. Other plates may not have 
the correct specification for optimal results.

3 The plate layout is as follows:

4 Seal the plate with a lid or plate sealer, and set it in the dark at room temperature 
for 4–24 hours.

IMPORTANT Do not touch the bottom of the plate. The laser scans through the 
bottom of the plate.

IMPORTANT The beads require at least 4 hours to settle to the bottom of the 
well.
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Setting Up the Run Parameters

Opening the New
Assay Wizard

Creating a
Two-Color Assay

To open the Assay Wizard: 

Step Action

1 From the Tools menu, select Assay Manager.

2 In the Assay Folders pane on the left, click Assays folder.

All the buttons become enabled and the default assay appears in the Contents pane 
on the right.

3 Open the New Assay Wizard. In the Assay Manager window:

� Click the New Assay button (  ) or

� From the File menu, select New Assay.

The New Assay Wizard opens with Instrument highlighted. 

To create a two-color assay: 

Step Action

1 In the Instrument window as shown below:

a. Use Factory Settings or PMT Gains set by your field service engineer.

b. Have the PMT Voltage Lock to Simple Ratio.

c. Set the Plate Type to 96 Well FMAT.

d. Click Next.
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2 In the Image Analysis window below:

a. Leave the event detection setting at 3 Standard Deviations.

b. Click Next.

3 In the Define Gates window below:

a. Click Color and place a check mark next to Color.

b. Type or move the bar(s) until the values are 0.90 and 0.40 as shown above.

c. Click Next.

To create a two-color assay: (continued)

Step Action
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4 In the Define Populations window below:

a. Place a check mark for Dye A to be PopA.

b. Place a check mark for Dye B to be PopB.

c. Click Next.

5 In the Outlier Analysis window below:

a. Place a check mark in all five measurements.

b. Use 3 Standard Deviations.

c. Click Next.

To create a two-color assay: (continued)

Step Action
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6 In the Plate Analysis window shown below:

a. Place check marks according to the table shown.

b. Click Next.

7 In the Well Setup window:

a. Make all wells Active.

b. Click Next.

To create a two-color assay: (continued)

Step Action
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8 In the Plate Naming window:

a. Leave at default settings as above.

b. Click Next.

9 In the Name window:

a. For Assay Name, type two color
Option: type in comments in the comment box.

b. Click Finish.

You should see your new assay title under the contents of the Assay pane in the 
Assay Manager.

10 Click Done to exit the Assay Manager window.

To create a two-color assay: (continued)

Step Action
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Creating a Runfile Before data can be collected, you must set up a runfile in the FMAT™ 8100 Analysis 
Software.

To create a runfile: 

Step Action

1 Open the FMAT system software.

2 From the File menu, select New Run.

The Create New Run dialog box opens.

3 From the Use Assay drop-down menu select two-color Assay.

4 For Place Plates, select Manually.

5 Type the name for the run into the File name text box.

IMPORTANT File or folder names cannot contain most special characters. Do not 
use the special characters: \ / : * ? “ < > | in a file/folder name. The FMAT system 
software will use the file name entered to create a folder by the same name. When 
special characters are used, the sample run fails because the software interprets 
these characters as specific commands and does not create the folder.

Note The software appends “.fmat” to the created file, so files are always named 
according to the format <filename>.fmat.
7-12 FMAT 2-Color Tutorial



Running the Instrument

Loading and
Scanning the Plate

You can scan the plate when the beads have settled to the bottom of the wells. Leave 
the plate in the dark, at room temperature, to settle for at least 4, but not more than 24, 
hours before scanning.

To load and scan a plate: 

Step Action

1 Open the scanner door by clicking the  Eject button.

2 Place the covered plate on the scanner tray so that the notched corner is located in 
the lower-left corner of the platform stage, pointing toward the front of the scanner.

Note Leave the plate lid on the plate when you place it in the FMAT instrument, or 
use a plate sealer.

LASER HAZARD. Do not remove the cover of the instrument. 
Exposure to direct or reflected laser light can burn the retina and leave permanent 
blind spots. Never look directly into the laser beam.

3 Click the Start Run icon ( ).

The Enter Plate Name dialog box opens for a manual run.

4 Click OK to the default plate name Plate001.

The plate is loaded and mapping starts.

IMPORTANT Once mapping starts, it cannot be stopped. The only way to stop is 
to power off the system.

5 Examine your data as it is being scanned in the Sample Detail Window.

You can change options as you view the data analysis:

� Image as Greyscale gives a greyscale display that shows relative intensities.

� Image as Histograms gives a three-dimensional height display that shows 
relative intensities.

� Image as Two Color shows the Dye A and Dye B events with selected colors but 
does not accurately show relative intensities.

6 When the scanning and data analysis are complete, the Enter Plate Name message 
box appears.

Click Cancel to close the message box.

WARNING!
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Viewing the Data

Viewing Your
Results

A successful assay gives the following results:

� All wells with beads have detectable FL1 fluorescence

� Relative intensities are detected in the correct order

� Dye A and Dye B events are distinct 

Looking at 3D Data The following example represents a good two color assay result.

Two Color Data in the 3 D Display 

Data Display Display shows...

Population A in FL1:

� Dye intensity from high to low, shows in 
display in appropriate wells.

� Presence of Dye A events detected in 
appropriate wells.

Population B in FL1:

� Dye intensity from high to low, shows in 
display in appropriate wells.

� Presence of Dye B events detected in 
appropriate wells.
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Looking at the
ColorPlot

The example below of well D9 shows a good separation of the two different 
populations by sorting them using the color gates. Dye B events are nicely clustered 
above 0.90 with a few outliers and Dye A events are clustered below 0.40.

Two-Color Data in the ColorPlot

Looking at the
ScatterPlot

The same data from well D9 is shown as a scatterplot and gives a similar pattern as 
the colorplot.

Two-Color Data in the ScatterPlot

-
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Making Your Own
Graph

You may want to generate your own graphs by using the data from the View Run 
Results in Helper plateview.cxr file. Examples of graphs using two color data of Dye A 
or Dye B and FL1 are below.

Average Fluorescence in Dye A Replicates Columns 9–12 vs. Bead Intensity

h

Average Fluorescence in Dye B Replicates Columns 9–12 vs. Bead Intensity

Both graphs show that each Dye A or B populations has four distinct populations 
relating to the dye intensity.

A
verage F

L1

% Bead Intensity

A
verage F

L1

% Bead Intensity
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Troubleshooting

Some Common
Problems

Note Please see “Troubleshooting” on page 6-1 for general troubleshooting information.

Observation Possible Solution

The graphs are not 
linear.

The lowest intensity of 
beads is not detected.

Because the intensities determined by flow 
cytometry are not identical to the FMAT 
determinations, the graph may not be perfectly 
linear.

If the non-linearity is extreme, or the lowest bead 
intensity is not detected, it may be that the PMTs 
are set too high or too low.

See “Retaining the Correct PMT Ratios” on 
page 5-5 and “Optimizing Data” on page 4-12.

Then rescan at the corrected PMT settings.

There are no beads in 
the image.

The images are blurry.

Make sure that you are using an FMAT-qualified 
plate.

Make sure that the beads were plated at least 
4 hrs prior to screening.

Make sure that you used the correct dilution.

Mix the beads and let them settle again, then 
rescan.

The two-color 
separation did not 
work.

The color parameters may need to be reset:

a. Click on one well.

b. Look at the color value.

c. Reset the color parameter to distinguish (gate) 
Dye A from Dye B events.

d. Reanalyze the data.
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A
The Run Window A
Overview

About This
Appendix

This appendix contains information about using the Run window in the FMAT™ 8100 
Analysis Software (system software). Information examples are provided for all the 
commands and tabs within the Run window, including the:

� Plate tab

� Table tab

� Scatterplot tab

� 3D tab

In This Appendix The following topics are covered in this appendix:

Topic See Page

About the Run Window A-2

About the Plate Tab A-3

About the Table Tab A-6

About the Scatterplot Tab A-7

About the 3D Tab A-9

About the Sample Detail Window A-10
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About the Run Window

Run Window The Run window is the window that is displayed when you open the FMAT system 
software. The Run window: 

� Shows the progress of a run

� Gives access to various displays of your data

� Provides tools to access all the FMAT options and features

An example of the Run window without run information displayed is shown below.

Sections in the Run
Window

The Run window has the following sections:

� The Menu bar along the top

� The Plates list box on the upper left side

� The Run Properties information pane on the lower left side

� The Plate, Table, Scatterplot, and 3D tabs

� The Status bar along the bottom

� The re-sizing arrows to adjust the pane size
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Displaying Data To display data about a run, you use the tabbed run displays. There are four tabs:

� Plate

� Table

� Scatterplot

� 3D

In addition, you can access the Sample Detail window from the menu bar to get a 
visual display of a single well.

About the Plate Tab The Plate tab is displayed by default when you open the FMAT system software. When 
no runs are open, it is blank. When you open a run, the display shows a grid of wells 
representing the number of wells in the plate-type that was used.

By using the drop-down menu at the top of the Plate tab, you can view the Plate 
display in three ways:

� Status

� Percentile

� Linear

Note The Status menu is enabled during scanning. The Percentile and Linear menus are 
enabled when the plate has finished scanning. 

Use these arrows to re-size the panes.
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Plate Tab Menus Plate Tab Drop-down Menus 

Menu Item Description

Status Shows whether the wells have been analyzed or not for the selected 
plate. 

� An un-scanned well is gray.

� A black box and a circle are displayed in a well when its scan is 
complete and an image file has been created.

� A triangle is displayed in the circle when the image has been 
analyzed and an analysis file has been created.

Percentile Shows a color in each well representing the percentile for the 
data/population settings. Percentiles are 10% each, ranging from 0 to 
100%. Percentiles are represented by the colors of the color bar on the 
top right of the plate grid.

Linear Shows a color in each well representing the linear data steps for the 
data/population settings. The linear data steps are developed by taking 
the range for a given data value and dividing it into ten equal parts. 
Linear data steps are represented by the colors of the color bar on the 
top right of the plate grid.
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Drop-down menus

By selecting either Percentile or Linear, the other drop-down menus become active 
and you can change the parameter and/or population selection.

Tooltips

By holding the cursor over a well in the Percentile or Linear view, a tooltip is displayed 
giving the value for that well. In Status view, a tooltip is displayed giving the row and 
column location of the well.

Color Bar

Change the colors of the display by clicking the color bar and selecting a new color.
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About the Table Tab The Table tab gives you results in a spreadsheet format, as shown below.

Column Heading Description

Plate Name or ID of the plate.

Row Plate row position of the wel.

Col Plate column position of the well.

Pop Population name for a data row.

Count Number of events in the well.

GatedCount The number of events in the well as determined by the Min Count 
option. See the note about Min Count on page 5-12 for more 
information.

FL1 The average intensity of the fluorescent events in PMT1.

FL2 The average intensity of the fluorescent events in PMT2.

Color The average FL2/FL1. This is indicative of the dye associated with the 
individual cell or bead.

Size The average full width at half max in the X dimension times that in the Y 
dimension.

Fit A measure of smoothness. This determines how well an event’s shape 
must fit a spline to be considered in a statistical analysis. The range is 0 
to 1, where a value closer to 0 is a better fit.
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About the
Scatterplot Tab

The Scatterplot tab gives you a scatterplot of your data.

There are three parameters that can be set to specify how to view your data:

� The Populations list 

� The X-Axis list 

� The Y-Axis list 

The Populations list allows you to select from one to all of the populations you have 
defined. Selections are made by clicking on the appropriate population.

The X-Axis and the Y-Axis lists allow you to select one each from the following 
parameters:

� FL1

� FL2

� Color

� Size

� Well#
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Using the
Scatterplot View

To use and adjust the scatterplot view: 

Step Action

1 View the measurements for each point on the plot:

a. Place the cursor over a point.

b. Right-click and release. A window opens with the measurement for the 
coordinate on the graph.

c. Left-click anywhere on the plot to close the window.

2 Double-click anywhere on the plot to open the Scatterplot Settings dialog box. 
You can also select the Tools menu and select Plot Properties.

3 Adjust the axes as needed:

a. Click the text box for the axis measurement you want to change.

b. Type in the new value that you want.

c. Click Apply.

Note Some points may go offscale and disappear when you adjust the axes, 
however these points are not lost and will reappear if you return to the original 
measurements. You may see a warning sign next to the Y-axis box as shown below.

4 Adjust the colors as needed:

a. Click Background Color or Foreground Dot Color.

b. When the Choose New Color dialog box opens, select the color you want and 
click OK. You can use any of the three tabs to do this.

c. Click Apply.

5 Click OK to exit the dialog box.
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About the 3D Tab The 3D tab gives you a three-dimensional bar chart of your plate data. The plate data 
is graphically represented, with each row displayed in a different color.

There are two drop-down menus in the right-side of this tab that allow you to select the 
parameters you want to use to view your data.

� The top list allows you to select any one or all of the populations you have defined.

� The bottom list allows you to select one of the following parameters:

– FL1

– FL2

– Color

– Size

– Fit

Changing the 3D
Perspective

You can view the 3D graph from different perspectives by rotating it or changing its 
size.

� Left-click a corner of the graph to rotate it in that direction. The graph rotates 
incrementally each time you click it.

� Right-click on the graph to change its size. 

Note You may need to switch to another tab to refresh the 3D screen.
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About the Sample Detail Window

Sample Detail
Window Overview

The Sample Detail window displays the data in each well of a plate when a run 
containing data is open. This window can be accessed in several ways:

� From the main View menu, by selecting Well Detail

� From the keyboard, by pressing Ctrl+D

� From the menu bar, by clicking the Well Detail button

� From the Plate tab, by double-clicking a well of interest

� From the Table tab, by double-clicking a well of interest

An example of the Sample Detail window is shown below.

Note If you want to open two windows at once, right-click a well and select New Well Detail.

The Sample Detail window has four tabs:

� Grayscale

� Histogram

� ScatterPlot

� ColorPlot

Detailed information about each of the four tabs is provided in the following sections.

The lower part of the window gives a grid display of the plate. You can select different 
wells for viewing by clicking on the desired well in this display.

Note You can export or print an image from the File menu in this window. You can also change 
displays or plot properties from the View menu.

Use these arrows to 
re-size the panes.
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Grayscale Display The Grayscale display offers ten Brightness values (Low, 2,3,4,5,6,7,8,9, High), 
representing segments in the data range (0 to 16,000).

Examples:

� A setting of Low is used when the background is high or when viewing bright 
events.

� A setting of High is used when viewing very dim fluorescent events.

� A setting of 6 is the default value.

Histogram Display The Histogram display is a three-dimensional height representation of the data.

There are ten scale values for viewing the data. Peak height is determined by 
multiplying the scale factor by 10 and normalizing the data to the result.

Examples:

� A setting of Low is used when the background is high or when viewing bright 
events.

� A setting of High is used when viewing very dim fluorescent events.

� A setting of 6 is the default value.
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ScatterPlot Display The ScatterPlot display gives a scatterplot of the individual events from a single well.

You can select the parameters for the plot using the Y Axis and X Axis drop-down 
menus just below the plot. Each drop-down menu offers the following options:

� FL1

� FL2

� Color

� Size

� Fit

� Event#

Viewing
Measurements

In the ScatterPlot display you can view the measurements for any location on the plot.

You can also make adjustments to the axes and color by using the Scattterplot 
Settings dialog box.

� Double-click anywhere on the graph, or

� Go to the View menu and select Plot Properties.

To view measurements:

Step Action

1 Place the cursor over a point.

2 Right-click and release.

A window opens with the measurement for the coordinate on the graph.

3 Left-click anywhere on the plot to close the window.
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ColorPlot Display The ColorPlot display allows colors to be assigned to fluorescent events.

There are ten Threshold levels to adjust the background signal.

Examples:

� Enter a ratio expected for Dye A in the lower field box. in the lower field box. 
Events with ratios equal to or below the ratio entered will have the Dye A assigned 
color.

� Enter a ratio expected for Dye B in the upper field box. Events with ratios equal to 
or above the ratio entered will have the Dye B assigned color.

� Events with ratios between the ratio entered for Dye A and Dye B will display a 
third color.
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Choosing New
Colors

Colors can be assigned for each of the three event values in the above examples. 
To assign colors, click a color box to display the Choose New Color window. 

An example of the Choose New Color window is shown below.

In the Choose New Color window, three tabs are available window:

� The Swatches tab

� The HSB (hue, saturation and brightness) tab 

� The RGB (red, green and blue) tab 

An example of each tab is shown below.

Note The ColorPlot display, which uses unprocessed data, should not be depended upon for 
numerical accuracy. For the best representation of results, refer to the Table tab (see “About the 
Table Tab” on page A-6).

Swatches HSB RGB
A-14 The Run Window



Determining
Two-Color Gates

To determine the color gates for a two-dye run: 

Step Action

1 Set up two wells as follows:

� One containing only Dye A sample

� One containing only Dye B sample

2 Analyze the wells.

3 Click Reanalyze this run button to open the Analysis Properties wizard.

4 Select and examine the Define Gates window. 

See the distribution of points, and adjust your gates accordingly (see“Reanalyzing 
the Run” on page 4-10).
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B
A Tour of the Menus B
Overview

About This
Appendix

This appendix provides information on the menu commands and buttons in the Assay 
Manager, Run window, and the Sample Detail window of the FMAT™ 8100 Analysis 
Software version 2.0.

In This Appendix The following topics are covered in this appendix:

Topic See Page

Run Window Menus B-2

Run Window Buttons B-7

Sample Detail Window Menus B-8

Assay Manager Menu B-9

Assay Manager Buttons B-10

Log Window Menus B-10
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Run Window Menus

Using the File Menu
in the Run Window

Refer to the following table for information about the File menu in the Run window. An 
example of the menu is shown below.

File Menu Details 

Menu Item
Keyboard 
Shortcut Description

New Run Ctrl+N Opens the Create New Run dialog box and allows you 
to:

� Name a new run

� Set run properties

� Set the assay to be used

� Define a new assay, if needed

Open Run Ctrl+O Opens the Open Run dialog box and allows you select 
and open an existing run by clicking on .fmat file.

Close Run — Closes the currently open run. 

Export Image — Opens the Save JPEG File dialog box and exports the 
JPEG-format images of the currently selected plate to 
a folder of your choice.

View Plates in Helper — Opens the individual well data from a selected plate in 
a spreadsheet, when a spreadsheet program has 
been selected in the Options window helper text 
boxes.

View Run Results In 
Helper

— Opens the plate-format data for all plates in an open 
run in a spreadsheet, when a spreadsheet program 
has been selected in the Options window helper text 
boxes.

View Well Listmode in 
Helper

— Opens the listmode file for the well that is highlighted, 
when a spreadsheet program has been selected in 
the Options window helper text boxes.

Import Plates — Opens the Select the FMAT v 1.0 RunDoc.txt file dialog 
box and allows you to add plate data to the currently 
open run.
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Exporting an Image An image of the Sample Detail window can be exported and saved in JPEG (Joint 
Photographic Experts Group) format.

Delete Plates — Allows you to delete the currently selected plate from 
the current run.

Page Setup — Opens the Page Setup dialog box and allows you to 
set the page characteristics for printing.

Print Ctrl+P Opens the Print dialog box and prints the contents of 
the Run window if you are connected to a printer.

Exit Alt+F4 Exits the program.

File Menu Details (continued)

Menu Item
Keyboard 
Shortcut Description

To export an image: 

Step Action

1 From the File menu, select Export Image.

The Save JPEG File dialog box opens.

2 Using the Look in pull-down menu, select a folder for storing your image.

3 In the File name textbox, type a name for your image.

4 Click Save.

Your image is saved to the location you specified.
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Printing an Image To obtain presentation graphics either export the screen image as a JPEG, or capture 
the screen image using Ctrl-Alt-Print Screen and import the image to a graphics 
program.

To print an image: 

Step Action

1 From File, select Page Setup and configure the screen image to fit to one page.

2 From the File menu, select Print. 

The Print dialog box opens.

3 Verify that your printer settings are correct, then click OK. The open window prints.

Note The application is frozen while the Print command completes.
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Using the View
Menu in the Run

Window

Refer to the following table for information about the View menu in the Run window. An 
example of the menu is shown below.

Using the
Instrument Menu in

the Run Window

Refer to the following table for information about the Instrument Menu in the Run 
window menu. An example of the menu is shown below.

View Menu in the Run Window Details 

Menu Item
Keyboard 
Shortcut Description

Plate Ctrl+1 Brings the Plate tab of the Run window to the front.

Table Ctrl+2 Brings the Table tab of the Run window to the front.

Scatterplot Chart Ctrl+3 Brings the Scatterplot tab of the Run window to the 
front.

3D Chart Ctrl+4 Brings the 3D tab of the Run window to the front.

Well Detail Ctrl+D Opens the Sample Detail window for the currently 
selected well.

New Well Detail Ctrl+Shift+D Opens additional Sample Detail windows.

Run Log — Opens the Run Log window.

Run History — Opens the Run History window.

Instrument Menu Details 

Menu Item
Keyboard 
Shortcut Description

Run Ctrl+R Starts a run.

Pause Ctrl+T Pauses a run.

Stop Ctrl+Y Stops a run.
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Using the Tools
Menu in the Run

Window

Refer to the following table for information about the Tools menu. An example of the 
menu is shown below.

Using the Help
Menu in the Run

Window

Refer to the following table for information about the Help menu. An example of the 
menu is shown below.

Eject — Ejects a plate.

Close Door — Closes the scanner door.

Delayed Start Ctrl+D Opens the Setup Delayed Start Time window.

Becomes enabled when you create a new run and 
select With Robot. 

Instrument Log — Opens the Instrument Log window.

Service — Enabled only for service engineers.

Instrument Menu Details (continued)

Menu Item
Keyboard 
Shortcut Description

 Tools Menu Details 

Menu Item
Keyboard 
Shortcut Description

Assay Manager Ctrl+M Opens the Assay Manager window.

Reanalyze Ctrl+R Opens the Analysis Properties wizard for the currently 
selected plate with the assay associated with the last 
reanalysis.

Plot Properties Ctrl+P Enable only when the Scatterplot tab has been 
selected. Opens the Scatterplot Properties dialog box.

Options Ctrl+O Opens the Options dialog box.

Users Ctrl+U Opens the User Manager dialog box.

Menu Item
Keyboard 
Shortcut Description

About FMAT Analysis — Opens the About FMAT Analysis window, giving 
you version and configuration information.
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Run Window Buttons

Using the Run
Window Buttons and

Functions

Refer to the following table for information about the Run window buttons and their 
functions. An example of each button is shown below.

Run Window Button Details 

Icon Button Name Function

New Run Opens the Create New Run dialog box and allows you to:

� Name a new run

� Set run properties

� Set the assay to be used

� Define a new assay, if needed

Open Run Opens the Open Run dialog box and allows you select and open 
an existing run.

Print Opens the Print dialog box and prints the contents of the Run 
window.

Start Run Starts a run.

Pause Run Pauses a run.

Stop Run Stops a run.

Eject Plate Ejects a plate.

Reanalyze Opens the Analysis Properties wizard for the currently selected 
plate with the assay associated with the last reanalysis.

Well Detail Opens the Sample Detail window for the currently selected well.
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Sample Detail Window Menus

Using the File Menu
in the Sample Detail

Window

Refer to the following table for information about the File menu in the Sample Detail 
window. An example of the menu is shown below.

Using the View
Menu in the Sample

Detail Window

Refer to the following table for information about the View menu in the Sample Detail 
window. An example of the menu is shown below.

Sample Detail Window File Menu Details 

Menu Item
Keyboard 
Shortcut Description

Export Image — Opens the Save JPEG File dialog box and exports the 
JPEG-format images of the currently selected well to a folder 
of your choice.

Print — Opens the Print dialog box and prints the contents of the 
Sample Detail window.

Exit — Closes the Sample Detail window.

Sample Detail Window View Menu Details 

Menu Item
Keyboard 
Shortcut Description

Grayscale — Brings the Grayscale tabbed display to the front.

Histogram — Brings the Histogram tabbed display to the front.

ScatterPlot — Brings the ScatterPlot tabbed display to the front.

ColorPlot — Brings the ColotPlot tabbed display to the front.

Plot Properties — Opens the Scatterplot Properties dialog box.

Enabled only when the ScatterPlot tabbed display is open. 
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Assay Manager Menu

Using the Assay
Manager File Menu

Refer to the following table for information about the File menu in the Assay Manager. 
An example of the menu is shown below.

Assay Manager File Menu Details 

Menu Item
Keyboard 
Shortcut Description

New Assay — Opens the New Assay Wizard.

New Folder — Enabled only when a folder is selected. Creates a new 
subfolder under the currently selected folder.

View — Enabled only when an assay is selected. Opens the Viewing 
wizard for the currently selected assay.

Edit — Enabled only when an assay is selected.

Duplicate — Makes a copy of the selected assay.

Delete — Deletes the selected assay.

Delete Folder — Deletes any selected folder other than the Assay folder. You 
cannot delete a folder containing assays created by another 
user ID.

Copy — Copies the selected assay to the clipboard.

Paste — Pastes a copy of the assay from the clipboard to the selected 
folder.

Import — Opens the Import Assay dialog box and allows you to select 
and import an assay to the selected folder.

Export — Opens the Export Assay dialog box and allows you to export 
a selected assay to the location of your choice.

Done — Closes the Assay Manager window.
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Assay Manager Buttons

Using the Assay
Manager Buttons

and Functions

Refer to the following table for information about the Assay Manager buttons and their 
functions. An example of each is shown below.

 Log Window Menus

Using the File Menu
in the Log Window

Refer to the following table for information about the File menu in the Log window. An 
example of the menu is shown below.

Assay Manager Buttons And Functions 

Icon Button Name Function

New Folder Creates a new folder.

Delete Folder Deletes a selected folder.

New Assay Opens the Assay Manager using the Default assay and 
creates a new assay.

Edit Assay Opens the Assay Manager using the selected assay and 
allows you to make changes.

Copy Assay Makes a copy of the selected assay.

Delete Assay Deletes the selected assay.

File Menu Details

Menu Item
Keyboard 
Shortcut Description

Page Setup — Opens the Page Setup dialog box and allows 
you to set the page characteristics for printing.

Print — Opens the Print dialog box and prints the 
contents of the Run window.
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Using the Edit Menu
in the Log Window

Refer to the following table for information about the Edit menu in the Log window. An 
example of the menu is shown below.

Using the View
Menu in the Log

Window

Refer to the following table for information about the View menu in the Log window. An 
example of the menu is shown below.

Edit Menu Details 

Menu Item
Keyboard 
Shortcut Description

Cut Ctrl+X Cuts the selected text and saves it in the clipboard.

Copy Ctrl+C Makes a copy of the selected text and saves it in the 
clipboard.

Paste Ctrl+V Pastes the contents of the clipboard into the selected 
location.

select-all Ctrl+A Selects all text in the open window.

View Menu Details 

Menu Item
Keyboard 
Shortcut Description

Instrument Log — Opens the Instrument Log window.

Run Log — Opens the Run Log window.

DEBUG — You can select any or all of these options. 

When selected, this type of message will be recorded in the 
log if it occurs while you are running the software.

INFO —

WARNING —

ERROR —

Refresh — Updates the log. 

The log does not automatically update while you are 
working. Select Refresh to see the most current entries in 
the log.
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C
Setting Up the Software C
Overview

About This
Appendix

This appendix describes new features of the FMAT™ 8100 Analysis Software 
version 2.0. How to install and set up the software for use with the FMAT™ 8100 HTS 
System is also described here. 

In This Appendix The following topics are covered in this appendix:

Topic See Page

New Features of the Software C-2

Installing the Software C-3

Starting the Software for the First Time C-4

Setting User Preferences C-7
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New Features of the Software 

About the Features
in Version 2.0

A number of new features have been added to the FMAT 8100 Analysis Software 
version 2.0.These include:

� Data collection using 96- and 384-well plates

� Logins with levels of accessibility and protection of protocols

� Both color and size multiplexing

� Export and save capabilities for images

� Data output in plate view

� Delayed start capability

� Repeat scanning of a plate or selected wells

� Wizards for assay design and management

� Integration with spreadsheet programs

� Improved algorithm for cells and beads

� Improved data analysis

IMPORTANT Be sure to read the Release Notes text file that is included on the software CD. 
The Release Notes will contain the very latest information about the software and any changes 
not included in this manual.
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Installing the Software

Overview The purpose of the FMAT system software is to direct the FMAT™ 8100 HTS System 
to collect and analyze data for specific assay types. The parameters for these assays 
are set in the software.

After you set up the assays in the software, you need only select the particular assay 
that you want for any given run. Each time you select that assay, your plate(s) are 
scanned and analyzed using the same parameters.

You may also reanalyze your data by selecting different assay parameters. However, 
the reanalysis still uses the original raw data gathered during the scanning of the 
plate(s), determined by the original instrument settings.

System
Requirements

Your system must meet the following minimum requirements to use the FMAT Analysis 
v 2.0 software:

� Microsoft® Windows NT® 4.0 with Service Pack 5 or above

� 500 MHz Pentium® processor

� 128 MB RAM

� 9 GB Hard Drive

� 10X CD-ROM

� Full color monitor with 800 x 600 resolution

� Network interface card

Installing the
Software

IMPORTANT We recommend that you back up all your data files and close all open programs 
before you begin the installation.

To install the FMAT v 2.0 software: 

Step Action

1 Place the CD-ROM into your CD-ROM drive.

2 Follow the instructions on the screens and continue clicking Next until the final 
screen, then click Finish.

Note If you do not want to install over the existing software, be sure to specify a 
different folder.
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Starting the Software for the First Time

Overview The software can operate in online mode or offline mode.

� In online mode, the software must be connected to an FMAT instrument. When 
connected, the system can scan plates and collect data.

� In offline mode, the system can open previous runs but cannot scan plates or 
collect data.

IMPORTANT Do not use a screen saver in online mode; it may conflict with the operation of 
the FMAT Analysis software. If necessary, turn off the screen saver using the computer’s 
Display control panel.

Assigning an
Administrator’s

Password

If you have installed the software yourself, the first time you start it you will be asked to 
assign an Administrator’s password using the dialog box shown below.

If the software is installed as part of a new system setup, your service engineer has 
assigned an Administrator’s password. However, if you ever have to reinstall the 
software, or if your password file becomes corrupted, follow the procedure below.

To assign an Administrator’s password: 

Step Action

1 In the Assign Administrator Password dialog box, in the Enter Password field, enter 
a password. 

Note It is good practice to use a password that is at least six characters in length 
and that contains numbers or symbols and letters.

IMPORTANT Be sure you use a password you will not forget.

2 In the Re-Enter Password field, type the password again for confirmation.

The OK button is enabled.

3 Click OK.
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Starting the
Software

Assigning User
Names

Only the Administrator can assign new user names.

To start the software for the first time: 

Step Action

1 Go to Start>Programs>FMAT 2.0.

Select the FMAT 8100 Analysis Software icon. 

The software opens. 

The Login dialog box opens.

2 a. Click Login to log in to the software using the default user name and no 
password.

b. If the computer is not connected to an FMAT instrument, the following warning 
appears.

c. Click OK to close this message and proceed.

The FMAT 8100 Analysis Software main window opens.

3 To perform administrative functions, such as assigning new user names, log in as 
Administrator.

a. From the pull-down list, select Administrator.

b. Enter your password.

c. Click Login.

To assign a new user name: 

Step Action

1 Start the software and log in as Administrator.

2 From the Tools menu, select Users.

The User Manager dialog box opens.
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Changing Your
Password

Once you have been assigned a user name, you can change your password any time 
you log on.

3 Click New.

The New User dialog box opens.

4 Type in the new user name and password, then click OK.

5 The user you added is now listed in the User Manager dialog box.

Click Save to save the new user and close the User Manager.

To assign a new user name: (continued)

Step Action

To change your password: 

Step Action

1 Click the Change Password button in the Login dialog box.

2 In the Change Password dialog box, enter the required information in the text boxes.

3 Click OK.
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Setting User Preferences

Overview You can set or change preferences for the following features and options at any time:

� Image storage options

� Instrument log display times

� Plate Result Helper

� Run Result Helper

� Delayed start time

Setting Options To set or change options: 

Step Action

1 From the Tools menu, select Options.

The Options dialog box opens.

2 Note Changing the following setting may prevent older runs from finding their 
image data. The images should always be kept with the runfile and run folder. 
Keeping the setting to the default of Store raw images in Run document will ensure 
that the images travel with their matching data files.

In the Data Image Storage group, click one of the following options:

� Store raw images in Run document

� Store raw images in a separate directory

Note If you select this option, and you do not want to use the default directory, 
click Browse to find and select the directory you want

� Don’t store raw images

3 In the Instrument Log group, type in the number of days for which you want 
information displayed.

4 Select a Plate Result Helper and a Run Result Helper. 

This allows you to open data files automatically in a spreadsheet.
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Setting Delayed
Start

Use the Setup Delayed Start Time dialog box to set a delayed start time. 

5

6 Click OK to exit the Options dialog box.

To set or change options: (continued)

Step Action

If you want to change... Then...

a helper (Microsoft Excel 
or another spreadsheet 
program)

a. Click the Browse button for the helper you want 
to change.

b. Select the location of the helper you want in the 
window that opens and click Set.

c. Click Apply.

IMPORTANT Be sure to select the .exe file for 
the program you want.

To set a delayed start: 

Step Action

1 Using the slider bar, select the amount of delay in minutes.

2 Note that the Delayed start time changes to reflect your selection.

3 Click Start.
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Applera Corporation, Applied Biosystems Limited Warranty Statement:

We at Applied Biosystems are committed to manufacturing of the highest quality 
possible for pharmaceutical research. We strive to ensure that our products meet your 
needs and expectations and are consistent with the latest advances in science, 
engineering, and technology. In accordance with our belief in the quality of our 
products, we are pleased to offer you the following limited warranty. 

Applera Corporation, through its Applied Biosystems Group (“Applied Biosystems”) 
warrants to the customer that, for a period ending on the earlier of one (1) year from 
the completion of installation or fifteen (15) months from the date of shipment to the 
customer (the “Warranty Period”), the FMAT™ 8100 HTS System purchased by the 
customer (the “Instrument”) will be free from defects in material and workmanship, and 
will perform in accordance with the performance specifications set forth in the 
Instrument Product Specification Sheet (the “Specifications”). 

During the Warranty Period, if the Instrument's hardware becomes damaged or 
contaminated or if the Instrument otherwise fails to meet the Specifications, Applied 
Biosystems will repair or replace the Instrument so that it meets the Specifications, at 
Applied Biosystems expense. 

This Warranty does not extend to any Instrument or part which has been (a) the 
subject of an accident, misuse, or neglect, (b) modified or repaired by a party other 
than Applied Biosystems, or (c) used in a manner not in accordance with the 
instructions contained in the Instrument User's Manual. This Warranty does not cover 
the customer-installable accessories or customer-installable consumable parts for the 
Instrument that are listed in the Instrument User's Manual. Those items are covered by 
their own warranties. 

Applied Biosystems obligation under this Warranty is limited to repairs or 
replacements that Applied Biosystems deems necessary to correct those failures of 
the Instrument to meet the Specifications of which Applied Biosystems is notified prior 
to expiration of the Warranty Period. All repairs and replacements under this Warranty 
will be performed by Applied Biosystems on site at the Customer's location at Applied 
Biosystems sole expense. 

No agent, employee, or representative of Applied Biosystems has any authority to 
bind Applied Biosystems to any affirmation, representation, or warranty concerning 
the Instrument that is not contained in Applied Biosystems printed product literature or 
this Warranty Statement. Any such affirmation, representation or warranty made by 
any agent, employee, or representative of Applied Biosystems will not be binding on 
Applied Biosystems.   
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Applied Biosystems shall not be liable for any incidental, special, or consequential 
loss, damage or expense directly or indirectly arising from the purchase or use of the 
Instrument. Applied Biosystems makes no warranty whatsoever with regard to 
products or parts furnished by third parties. 

This Warranty is not transferable. 

THIS WARRANTY IS THE SOLE AND EXCLUSIVE WARRANTY AS TO THE 
INSTRUMENT AND IS IN LIEU OF ANY OTHER EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF 
MERCHANT ABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND IS IN 
LIEU OF ANY OTHER OBLIGATION ON THE PART OF APPLIED BIOSYSTEMS.
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Contacting Technical
Support

You can contact Applied Biosystems for technical support:

� By e-mail

� By telephone or fax

� Through the Applied Biosystems web site

You can order Applied Biosystems user documents, MSDSs, certificates of analysis, 
and other related documents 24 hours a day. In addition, you can download 
documents in PDF format from the Applied Biosystems web site. (Please see the 
section “To Obtain Technical Documents” following the telephone information below)

To Contact Technical
Support by E-Mail

To contact Applied Biosystems Technical Support by e-mail for help in the following 
product areas:

Product/Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems and PCR pcrlab@appliedbiosystems.com

Protein Sequencing, Peptide, and DNA 
Synthesis

corelab@appliedbiosystems.com

Biochromatography

PerSeptive DNA, PNA and Peptide 
Synthesis systems

FMAT 8100 HTS System

CytoFluor® 4000 Fluorescence Plate Reader

Mariner Mass Spectrometers

Voyager Mass Spectrometers

MassGenotyping Solution 1™ (MGS1) 
System

tsupport@appliedbiosystems.com

LC/MS 
(Applied Biosystems/MDS Sciex)

support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com
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To Contact Technical
Support by

Telephone or Fax
(North America)

To contact Applied Biosystems Technical Support in North America, use the telephone 
or fax numbers in the table below.

Note To schedule a service call for other support needs, or in case of an emergency, dial 
1.800.831.6844, then press 1.

Product/Product Area Telephone Fax

ABI PRISM® 3700 DNA Analyzer 1.800.831.6844, 
then press 8a

1.650.638.5981

DNA Synthesis 1.800.831.6844, 
press 2, then press 1a

1.650.638.5981

Fluorescent DNA Sequencing 1.800.831.6844, 
press 2, then press 2a

1.650.638.5981

Fluorescent Fragment Analysis 
(including GeneScan® applications)

1.800.831.6844, 
press 2, then press 3a

1.650.638.5981

Integrated Thermal Cyclers (ABI PRISM® 

877 and Catalyst 800 instruments)
1.800.831.6844, 
press 2, then press 4a

1.650.638.5981

ABI PRISM® 3100 Genetic Analyzer 1.800.831.6844, 
press 2, then press 6a

1.650.638.5981

Peptide Synthesis 
(433 and 43x Systems)

1.800.831.6844, 
press 3, then press 1a

1.650.638.5981

Protein Sequencing 
(Procise® Protein Sequencing Systems)

1.800.831.6844, 
press 3, then press 2a

1.650.638.5981

PCR and Sequence Detection 1.800.762.4001, 
then press:

1 for PCRa

2 for TaqMan® 
applications and 
Sequence Detection 
Systems including 
ABI Prism‚ 7700, 
7900, and 5700a

6 for the 6700 
Automated Sample 
Prep Systema

or

1.800.831.6844, then 
press 5a

1.240.453.4613

Voyager MALDI-TOF Biospectrometry 
Workstations

Mariner ESI-TOF Mass Spectrometry 
Workstations

MassGenotyping Solution 1 (MGS1) 
System

1.800.899.5858, 
press 1, then press 3b

1.508.383.7855

Biochromatography 
(BioCAD®, SPRINT, VISION, and 
INTEGRAL®  Workstations and POROS® 
Perfusion Chromatography Products)

1.800.899.5858, 
press 1, then press 4b

1.508.383.7855

Expedite Nucleic Acid Synthesis 
Systems

1.800.899.5858, 
press 1, then press 5b

1.508.383.7855
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a. 5:30 AM to 5:00 PM Pacific time.

b. 8:00 AM to 6:00 PM Eastern time.

c. 9:00 AM to 5:00 PM Eastern time.

To Contact Technical
Support by

Telephone or Fax
(Outside North

America)

To contact Applied Biosystems Technical Support or Field Service outside North 
America, use the telephone or fax numbers below.

Peptide Synthesis (Pioneer and 9050 
Plus Peptide Synthesizers)

1.800.899.5858, 
press 1, then press 5b

1.508.383.7855

PNA Custom and Synthesis 1.800.899.5858, 
press 1, then press 5b

1.508.383.7855

FMAT 8100 HTS System

CytoFluor® 4000 Fluorescence Plate 
Reader

1.800.899.5858, 
press 1, then press 6b

1.508.383.7855

Chemiluminescence (Tropix) 1.800.542.2369 
(U.S. only),
or 1.781.271.0045c

1.781.275.8581

LC/MS 
(Applied Biosystems/MDS Sciex)

1.800.952.4716 1.508.383.7899

Product/Product Area Telephone Fax

Region Telephone Fax

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria) 61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 or
86 800 8100497

86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

India (New Delhi) 91 11 653 3743/3744 91 11 653 3138

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 79588268 60 3 79549043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 532 4484 32 (0)2 582 1886

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0)6150 101 0 49 (0)6150 101 101

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Portugal (Lisboa) 351.(0)22.605.33.14 351.(0)22.605.33.15

Spain (Tres Cantos) 34.(0)91.806.1210 34.(0)91.806.12.06
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To Reach Technical
Support Through

the Applied
Biosystems Web Site

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands (Nieuwerkerk a/d 
IJssel)

31 (0)180 392400 31 (0)180 392409 or
31 (0)180 392499

United Kingdom (Warrington, Cheshire) 44 (0)1925 825650 44 (0)1925 282502

European Managed Territories (EMT)

Africa, English speaking
(Johannesburg, South Africa)

27 11 478 0411 27 11 478 0349

Africa, French speaking
(Paris, France)

33 1 69 59 85 11 33 1 69 59 85 00

India (New Delhi) 91 11 653 3743

91 11 653 3744

91 11 653 3138

Poland, Lithuania, Latvia, and Estonia 
(Warszawa)

48 22 866 40 10 48 22 866 40 20

For all other EMT countries not listed 
(Central and southeast Europe, CIS, 
Middle East, and West Asia)

44 1925 282481 44 1925 282509

Japan

Japan (Hacchobori, Chuo-Ku, Tokyo) 81 3 5566 6230 81 3 5566 6507

Latin America

Caribbean countries, Mexico, and 
Central America

52 55 35 3610 52 55 66 2308

Brazil 0 800 704 9004 or 
55 11 5070 9654

55 11 5070 9694/95

Argentina 800 666 0096 55 11 5070 9694/95

Chile 1230 020 9102 55 11 5070 9694/95

Uruguay 0004 055 654 55 11 5070 9694/95

Region Telephone Fax

To contact Technical Support through the Applied Biosystems web site: 

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click Frequently Asked 
Questions.

3 Click Contact Support in the contents list at the left of the screen.

4 Click your geographic region for the product area of interest.

5 In the Personal Assistance form, enter the requested information and your 
question, then click Ask Us RIGHT NOW.

6 In the Customer Information form, enter the requested information, then click Ask 
Us RIGHT NOW.

Within 24 to 48 hours, you will receive an e-mail reply to your question from an 
Applied Biosystems technical expert.
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To Obtain Technical
Documents

You can obtain technical documents, such as Applied Biosystems user documents, 
MSDSs, certificates of analysis, and other related documents for free, 24 hours a day. 
You can obtain documents:

� By telephone

� Through the Applied Biosystems web site

Ordering Documents by Telephone

Obtaining Documents Through the Web Site

To Obtain Customer
Training

Information

To order documents by telephone:

1 From the U.S. or Canada, dial 1.800.487.6809, or from outside the U.S. and Canada, 
dial 1.858.712.0317.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.

To view, download, or order documents through the Applied Biosystems web site:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click Documents on 
Demand.

3 In the search form, enter and select search criteria, then click Search at the bottom 
of the page.

4 In the results screen, do any of the following:

� Click the pdf icon to view a PDF version of the document.

� Right-click the pdf icon, then select Save Target As to download a copy of the 
PDF file.

� Select the Fax check box, then click Deliver Selected Documents Now to have the 
document faxed to you.

� Select the Email check box, then click Deliver Selected Documents Now to have 
the document (PDF format) e-mailed to you.

Note There is a limit of five documents per fax request, but no limit on the number 
of documents per e-mail request.

To obtain Applied Biosystems training information:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click Training.
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